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1. Inova LightLink Administrator Introduction 

Inova LightLink® Administrator provides an interface for configuring and 
monitoring the Inova LightLink system.  LightLink Administrator will connect to 
the hosts distributed across the Inova LightLink system to configure and monitor 
LightLink components.  

LightLink Administrator is the central tool for configuring the components of the 
LightLink system.  The components of the Inova LightLink system connect to 
each other via the Object Bus (for data information) and the Data Directory (for 
configuration information) to gather and monitor the data you wish to analyze 
and display.   

LightLink Administrator is installed with the LightLink Middleware and as such 
is only available on LightLink Middleware hosts.  Permissions for running the 
Administrator application are set and controlled by the LightLink Security 
Manager application. Because LightLink Administrator connects directly to the 
LightLink database, users running Administrator must have LightLink database 
permissions commensurate with the LightLink Middleware processes.  Using the 
default settings for the LightLink database ensures that users running LightLink 
Administrator have the correct permissions. 

LightLink Administrator provides views into the configuration of the LightLink 
system at a site.  There is a Host View that lists the configuration by the various 
hosts participating in the system, and there is a Global View that lists the 
configuration by the types of LightLink connections to the system (client 
manager, input manager, and output manager connections). 

LightLink System Node - At the highest level in each view is the LightLink 
System node, entitled with the Organization Name that was specified during the 
primary server middleware installation.   

Host View - In the Host View, there are host nodes below the System node.  A 
host node shows the LightLink components currently configured on that host.  
The LightLink components are: Auditor, Client Manager, Data Directory 
(Publisher or Uses Remote – the Subscriber type is legacy only), External Input 
Manager, Input Manager, Object Bus, Output Manager, and Site Monitor. 

Global View – In the Global View, the types of LightLink connections across all 
the hosts in the system are displayed below the System node.  This view lists all 
of the Data Source Managers (DSMs) in the system under the Input Manager 
node, all of the Output Channel Managers (OCMs) under the Output Manager 
node, and all of the current connections to the Client Manager(s) in the system 
under the Client Manager node. 
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There are numerous sources of input data possible for a LightLink system, 
including data from various Automated Call Distribution (ACD) systems, 
database sources, and XML data from files and Universal Resource Locators 
(URLs, e.g., web servers).  In addition, there are two LightLink specific data 
sources: System Data (system date-time and system monitoring information), 
and Data Analysis Data (data derived from other data sources, for example, 
performing statistical functions). 

The following Output Device Connections and devices are possible in a 
LightLink system, depending upon the Inova LightLink License Key: 

• Inova TCP/IP Displays (Inova OnTrack displays) 

• Inova Desktop Presenter clients: 

− Marquee 

− DataLink 

− TaskLink 

• Database Publisher  

• XML Publisher 

• Email Output 

• Inova TCP/IP Displays – Encrypted (Inova OnAlert or Simplex 
TrueAlert) 

• AMS LED Displays 
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2. Administrator - Navigation 

Start LightLink Administrator by completing the following steps for one these 
methods: 

• LightLink Quick Launch > Administrator 

• Start > All Programs > Inova Solutions  > LightLink Middleware >  
Administrator 

When LightLink security is active, the user account launching the Administrator 
application will be validated against the user list of the LightLink™ Security 
Groups. If the user account is not in one of the Inova LightLink Security Groups, 
or if present but disallowed from running Administrator, the application will 
display a message to that effect and will shut down. When LightLink security is 
dormant, this check will not be made. Refer to the LightLink Security Manager 
User Guide for more information. 

Select the Host View to see and be able to make changes to the LightLink 
Administrator system (connections, nodes and components).  To navigate 
through the Inova LightLink system using the Host View: 

1. From the Administrator main screen, select Host View from the bottom of 
the Administrator screen to see the existing connections.  

2. To view these connections, if any, click on the plus sign to the left of the 
connection in the left-hand window of the main screen. 

3. Click on the plus sign of a branch point to show more detail and on the 
minus sign of a branch point to "close" and show less detail. 

2.1. Requesting and Releasing Configuration Permission 

In order to make changes to the LightLink system tree (e.g., adding or renaming 
connections and changing entries on the Properties dialogs), you must have 
configuration permissions at the time that you attempt to make the changes.   

To use the Configuration Permission option in LightLink Administrator, select 
Tools > Config Permissions > Request Configuration Permission.  

To check if you have requested configuration permissions, look for the padlock 
at the bottom of the screen.  In Figure 1, the operator has not yet requested 
permissions; you can tell because the padlock at the bottom is unlocked. 

 

Figure 1 
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If you still need to obtain configuration permissions, Administrator will display 
the following: 

• The Release Configuration Permission option will be grayed out when 
you choose Tools > Config. 

• The toolbar button on the far right appears to be flush with the toolbar. 

• The open lock icon appears on the Status bar at the bottom center of 
the screen. 

If you already have configuration permissions, Administrator will appear as 
follows (Figure 2): 

• The Request Configuration Permission option will be grayed out when 
you choose Tools > Config. 

• The toolbar button on the far right appears to be pushed in. 

• The message "Configuration Permission Enabled" appears briefly at 
the bottom right, and the closed lock icon appears on the Status bar at 
the bottom center of the screen. 

 

Figure 2 

2.2. LightLink System Tree  

The LightLink system tree shows the hierarchical structure for the Inova 
LightLink system.  Each node in the tree can have one or more sub nodes directly 
beneath it. For example, the Input Manager node has DSM nodes beneath it, and 
each DSM node has nodes representing the data groups and data fields it 
provides to the LightLink system.   

There are plus signs and minus signs at each node that contains sub-nodes. 
Clicking on the plus sign "expands" that node to show more detail; clicking on 
the minus sign "collapses" that node to show less detail. 

An example of the LightLink system tree is shown in Figure 3. 
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Figure 3 

2.2.1. Host View/Global View 

You can navigate through LightLink Administrator using the LightLink system 
tree, which allows you to view the system components across the entire system.  
There is a tab on this control that allows you to view the system in a host view 
layout or a global view layout (Figure 4).  

Double clicking on a tree node will bring up the properties dialog for that 
component.  

Not all components will always be shown under a Host View; only the components that 
have been configured for that host will appear.  

 

Figure 4 
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In the host layout, all components of the system are organized under a node 
representing a host.   This allows you to see all items associated with a particular 
host.  

In the global layout, you can view all items in the system by their type 
regardless of location. The global view will always show all components 
displayed.  Choose the Global View to see a hierarchical display of your system, 
grouped by component type (e.g., Servers, Connections, and Items). 

• All Client Managers are represented by a single Client Manager icon 
with all the Client Connections in the system shown on sub-branches. 

• All Input Managers are represented by a single Input Manager icon 
with all the Data Source Connections in the system shown on sub-
branches. 

• All Output Managers are represented by a single Output Manager icon 
with all Output Device Connections (and their related devices) in the 
system shown on sub-branches. 
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2.3. Administrator Context Menu 

LightLink Administrator provides context menus to perform configuration and 
monitoring actions within the LightLink system.  The context menu is content 
sensitive and will have different items depending on the tree nodes selected.  For 
example, New will only be provided in instances where there is an option to add 
a new item to the LightLink configuration.  

To open the context menu, right click on the desired node. You can also access a 
context menu by choosing the desired node and then clicking Edit > Node from the menu 
bar.   

Many operations in LightLink Administrator can be performed through a context 
menu for the node in the LightLink system tree. The context menu is available by 
right-clicking on the node as well as through the Edit > Node menu. Sections 
2.3.3 through 2.3.6 describe the common context menu items available for most 
nodes. Later sections in this document discuss the context menu options that 
apply to the different kinds of system components.   

2.3.1. LightLink System Context Menu 

Select the Site node and open the context menu.  Refer to Table 1 for details about 
the host context menu items. 

Menu Item Explanation 

Start the entire LightLink System... Issue a command to all LightLink hosts to 
start the LightLink software 

Stop the entire LightLink System... Issue a command to all LightLink hosts to 
shutdown the LightLink software 

Generate Version Report Generate a version report for each host. 

Properties Show the License information for this 
LightLink site. 
Table 1 

2.3.2. Multiple Selection 

LightLink Administrator supports multiple selections in the LightLink system 
tree. When this is done, the Administrator only shows a context menu that is 
appropriate to all items selected.  

If several components are selected, the context menu would show only the menu 
functions that are common to all. If you select several server components, the 
menu would provide only three menu items:  Add to View Window, Start 
Component, and Stop Component (Figure 5).  
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If a host and a server component item are selected then only the Add to view 
window item is available (Figure 6). 

 
 

Figure 5 Figure 6 

2.3.3. Adding to View Window  

Adding an item to a view window provides details about that item, such as its 
LightLink identifier, current status, or current value. This can be done from 
either the context menu or by dragging the item to an already-open view 
window.  Refer to Section 4.2 for more information about creating a view 
window. To add an item:   

1. From the LightLink system tree, select the desired node(s) and right click 
to bring up the context menu. 

2. From the context menu, select Add to View Window; if only one view 
window is open the items are added to that window; if none or more than 
one view window is open, the Select a View Window dialog pops up. 

3. In the Select a View Window dialog, choose the view window to which to 
add the selected item(s), or create a new view window.  

2.3.4. Renaming an Item  

Rename an item to change its display name (e.g., to a more meaningful name); 
not all options will be available for every node.  You can rename an item by 
either:  

• Right clicking on the desired node to open the context menu.  Select 
Rename.   

• Right clicking on the desired node to open the context menu.  Select 
Properties.  Change the name in the Properties dialog.     
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2.3.5. Deleting an Item 

Delete an item to remove that item from the LightLink configuration.  To delete 
an item: 

1. Right click on the item to be deleted.   

2. Select Delete from the context menu. 

Note that different types of items will display different requirements and behaviors.  For 
example, to delete a host node, the launcher on that node must be turned off; you 
can delete a data field, but that data field will be recreated in LightLink with a 
new ID if the source delivers an update in the position represented.   

If you are attempting to delete a data field, you will receive a warning if that data 
field is in use by an output device.  (For data fields used by DADSM equations, 
there is a log file, DADSM_Datafield_Usage.log, that lists the data fields in use 
by DADSM.)  If a data field is in use when deleted and the data source continues 
to provide values, then it will be recreated with a different data field ID, and any 
output destinations that use it will have to be updated (e.g., if in a LightLink 
message, then edit the message to use the recreated data field of the same name, 
and resend the message). 

2.3.6. Version Report Dialog 

LightLink Administrator allows for the remote reporting of LightLink file 
versions. You can select the hosts to have a report run and select the Generate 
Version Report menu item from the context menu or the Edit/Node menu. 
Alternatively, you can select the same item from the Site-level node and a report 
will be run on all machines. 

When selected, the version_reporter.exe application is launched on each remote 
machine. This application goes through the Inova LightLink/exe directory and 
compiles a list of files and file versions. It sends this list back to LightLink 
Administrator via the object bus and terminates. LightLink Administrator 
collects all the reports and displays them in the Version Report Dialog. 

To access the LightLink Version Report from the Administrator main screen, 
select the Site node > Generate Version Report. 

The LightLink Version Report dialog appears. 

The Version Report dialog has a list box on the left side that allows the selection 
of a particular host that has responded to the version report request. When 
selected, the host version report is displayed in the right-hand list box with a 
column header for the file and the version.  
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The buttons in the lower-left corner allow you to specify if all files should be 
shown regardless of version number, or to only show files whose version differs 
from that shown at the upper-left corner of the screen. 

2.4. License Properties and the License Key 

The Administrator Properties dialog shows the Server ID and license key 
assigned by Inova to your installation and included with your Inova LightLink 
license agreement.  Both must be entered here for proper Inova LightLink 
Administrator operation. 

The license key includes information that enables certain license-restricted 
features based on the options you have purchased with your Inova LightLink 
system. The Details button will activate a dialog that displays these options. 

If you purchase additional options for your Inova LightLink system, you will be 
assigned a new license key by Inova. 

To activate your license: 

1. Open the Administrator Properties dialog. 

2. To activate the new options you have purchased, type in your license key. 
Note that the Server ID, encoded License Key, and details of your Inova 
LightLink license will now be displayed as part of this dialog.  The License 
Details dialog describes the allowable configuration of the Inova 
LightLink system. 

To edit your Server ID, you will need to run setup and repeat installation 
of the software with a different Server ID. 

3. Select OK to complete the configuration.   

You must shut down and restart Administrator for these new options to become 
activated. 
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3. Host Configuration 

You can configure which components run on a LightLink Host.   The most 
common reasons to configure a Middleware host are to specialize a secondary 
Middleware host as an Input Manager host only or an Output Manager host 
only.  An Input Manager host would only acquire data for other Middleware 
hosts to consume; an Output Manager host would only send messages and data 
to output destinations.  Another reason is to unassign the External Input 
Manager if it is not put into use on a given host. 

3.1. Host Configuration 

To configure which services are to run on a given host, you must configure that 
host using LightLink Administrator: 

1. Select the Host View tab. 

2. Right-click on the selected host to bring up the host context menu.  

3. Select Configure Components. 

You must have configuration permissions to begin (see Section 2.1). 

The Host Component Configuration dialog appears (Figure 7). The 
services that are available for the user to configure appear in the left 
window. The services that are already configured appear in the right 
window. 

 

Figure 7 

4. To assign Available Services: 

a. Select the desired service in the left window.  

b. Click  >> to add that service to the right-hand pane window. 

5. To unassign Configured Services: 

a. Select the desired service in the right window. 
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b. Click << to unassign that service and return it to the left window. 

c. To remove components, the components must first be stopped using the 
Stop Server item on the item menu. If it is running when you attempt 
to remove it from the configured services list, a dialog pops up 
stating that the component must be stopped before removing it; if 
you click OK, the component will be stopped for you. 

6. Select Done to complete the initial configuration. 

3.2. Host Context Menu 

Select a Host and open the context menu.  Refer to Table 2 for details about the 
host context menu items. 

Menu Item Explanation 

Add to View Window Add this to an open view window 

Configure Components Display the Host Component Configuration 
dialog to edit the server components running on 
this host 

Delete Remove this host from the system 

Start all LightLink Software ... Start the LightLink software on this host 

Stop all LightLink Software ... Shutdown the LightLink software on this host 

Generate Version Report Generate a version report for this host 

Properties   Display the Host Configuration dialog to modify 
the Display name and configure the Object Bus 
and Client Manager for this host 

Table 2 
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4. Monitoring and Modifying System Components 

4.1.  Administrator Options  

1. Select Tools > Options. 

2.  The Administrator Options dialog appears.  Complete the system 
configuration options :  

• Enable System Configuration Permission: 

− Always request at startup tab – select to have the system 
automatically try to obtain the config lock when Administrator 
starts running. 

− Request Timeout (seconds) - number of seconds after which a 
request for config permission will timeout if it is not successful.    

− Release lock after (mins) - number of minutes after which 
Administrator will automatically release config permission so 
indicated by the unlocked icon that appears at the bottom center of 
the screen.   

• Timeouts: 

− Garbage Collect every (seconds) - Select this option to specify how 
long in seconds Inova LightLink will keep times associated with a 
closed node.   

− Update Items every (seconds) - How often Administrator refreshes 
information about visible nodes in the LightLink system tree. 

• Startup settings: 

− Always show Startup Page - Select to show the startup page. 

To improve system efficiency during startup, select this option to launch 
Administrator with the Startup Page instead of the Host View tab visible. 

3. Select OK to complete the configuration. 

4.2. Creating and Managing View Windows 

The view window is a panel to which a user can drag an item from the LightLink 
system tree and view its attributes.  

To create a new View Window, select File > New.  On the View Window 
Attributes dialog, enter the name of your new View Window and click OK.  The 
new View Window will appear on the right side of your Administrator screen.   
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You can navigate among multiple View Windows either by using the Window 
menu item at the top of the screen or by using the tabs under the menu icons 
(Figure 8). Note that the Window menu option allows you to select cascade or 
tile view for multiple windows.   

 

Figure 8 

  View Windows provide basic windowing functionality: 

• Minimize and maximize using the buttons at the top right of each 
window. 

• Save / Save As using the File > Save / Save As path.   

• Open a saved View Window using the File > Open menu option.   

You can add an item to the View Window through the context menu for the item 
or by dragging and dropping the item into the desired View Window.   
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5. Auditor  

LightLink Auditor is an event monitoring component that logs events related to 
Inova LightLink system performance.  It can provide up-to-date information for 
immediate use and log events for historical reports. LightLink Auditor will: 

• Collate the various entries in each LightLink host computer’s 
local_system_event.log file and enter them into the system-wide 
system_event.log on the primary host computer. 

• Record audit events to the Audit database. Refer to Section 5.4 for more 
details of this feature. 

• Generate a snapshot of the current LightLink configuration and record it 
to the Audit database. Refer to Section 5.3 for more details of this feature. 

• Generate a report of system usage compared to the license allocations. 
Refer to Section 0 for more details of this feature. 

• Use Desktop AutoSweep to remove Desktop Presenter Clients that are 
inactive for specified periods of time. Refer to Section 5.6 for more details 
of this feature. 

5.1. Auditor Context Menu   

Refer to Table 3 for details about the context menu items. 

Menu Item Explanation 

Add to View Window Add the Auditor component to the open view 
window 

Generate Snapshot Generate a snapshot of the current state of the 
audited components in the LightLink system 

View License Report View the License Report that lists the LightLink 
components licensed for this system and their 
current usage 

Start Component Start the Auditor component 

Stop Component Stop the Auditor component 

Properties Set the properties for the Auditor component 
Table 3 
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5.2. Auditor Properties 

To set the properties for LightLink Auditor:  

1. Open the Auditor Properties dialog; it will have two tabs: Settings and 
Desktop AutoSweep.   

2. Complete the following fields on the Settings tab: 

• Record Events: - Check the box to enable recording of audit events. 

Modify Keep events for ___ days to specify how many days to keep 
events; events that were recorded more than the specified number of 
days previously will be periodically deleted.  

• Run Periodic Snapshot- Check the box to enable periodic snapshot 
recording. 

Choose a Daily Snapshot Time to select the time of day that the 
snapshot should be taken every day.  

3. Complete the following fields on the Desktop AutoSweep tab (Figure 9): 

• Number of days – Click on each Output Channel and then enter a 
number of days, between 30 and 365.  Any Desktop Client added to 
this Output Channel will be removed after this number of days 
without being logged in.  

Specifying zero (0) for a channel turns off this feature so that no 
Desktop Client users are removed from the Output Channel.  Refer to 
Section 7.5 for more details of this feature. 

• Evaluation Settings - Choose to either report expired desktop clients 
or to report and remove expired desktop clients.  The report is written 
to the auditor log (i_auditserver.log), which you can review by using 
the Log Viewer tool. 

Select Report expired desktop clients to generate a report of inactive 
desktop clients that have not logged in for your specified number of 
days.  

If you select Report and remove expired desktop clients, the system will 
generate a report and will remove inactive desktop clients that have 
not logged in for your specified number of days. 

Note that if you enter zero in the Number of Days field, then the Evaluation 
Settings are not implemented for that output channel. 
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• Perform Evaluation Now – Select this box to perform the evaluation 
for expired desktop clients at this time.  Regardless of the setting of 
this checkbox, an evaluation occurs at 5:00 am every day. 

If you choose to perform the evaluation now and you have selected 
Report and remove expired desktop clients, the system will remove expired 
desktop clients after you click OK. 

 

Figure 9 

4. Click OK to complete the Auditor properties configuration. 

5.3. Audit Snapshots 

LightLink Auditor will record to the audit database the current configuration of 
the LightLink system as a snapshot in time.  Information for all messages, data 
sources, data fields, output channels, and output devices configured in the Inova 
LightLink system will be recorded.  The following information will be recorded: 

• Type of component (i.e. message, data source, data field, output 
channel, output device)  

• Timestamp of snapshot 

• Appropriate Inova LightLink object ID 

• Description of component (optional) 

To generate a snapshot, from the Administrator main menu: 
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1. Right click on Auditor to open the context menu.   

2. Select Generate Snapshot. 

A snapshot can also be scheduled to run at a given time daily.  Refer to Section 0 
for more information.  

5.4. Audit Event Content 

Audit Events are recorded in the Audit database.  The Audit database is in 
Microsoft Access format and resides in the Server\srvcfg\audit folder within the 
LightLink installation location. Table 4 lists details about triggering events and 
information included in audit database records. 

Information 
Type 

Triggering Event Details in audit record 

Data Source When a Data Source is:  

• created 

• modified 

• deleted 

• Data Source Name (description) 

• Data Source ID within Inova LightLink 

• Timestamp of event  

• User that initiated the event (if applicable) 

• Event (create, modify, delete)  

Data Field When a data field is: 

• created 

• modified 

• deleted 

• Field description (optional) 

• Field ID within Inova LightLink  

• Timestamp of event 

• User that initiated the event (if applicable) 

• Type of event (creation, modification, deletion) 

Display 
Group 

When a Display Group 
is: 

• created 

• modified 

• deleted 

• Display Group name 

• ID within Inova LightLink  

• Timestamp of event 

• User that initiated the event (if applicable) 

• Type of event (creation, modification, deletion) 

Message When a message is: 

• sent 

• modified 

• deactivated 

• deleted 

• Message title and message ID within LightLink 

• Timestamp of event  

• User that initiated the event (if applicable) 

• Event (send, modify, deactivate, delete)  

• Any textual explanation to accompany the event 
(optional) 

Output 
Device 

When an output 
device is: 

• created 

• modified 

• deleted 

• logged in 

• logged out 

• Device Type 

• Device ID within Inova LightLink 

• Timestamp of event  

• User that initiated the event (if applicable) 

• Event (create, modify, delete, login, logout)  

• Any textual explanation to accompany the event 
(optional) 
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Output 
Channel 

When an output 
channel is: 

• created 

• modified 

• deleted 

• Channel Type 

• Channel ID within Inova LightLink 

• Timestamp of event  

• User that initiated the event (if applicable) 

• Event (create, modify, delete)  

• Any textual explanation to accompany the event 
(optional) 

Security 
Group 

When a security group 
is: 

• created 

• deleted 

• modified 

• Name of the group 

• Security Group ID within Inova LightLink 

• Timestamp of event 

• User that initiated the event (if applicable) 

• Type of event (creation, deletion, membership 
modification, privilege modification, access rights 
modification)  

•  Any textual explanation to accompany the event 
(optional) 

Security User When a user account: 

• is created 

• is deleted 

• has its privileges or 
access rights 
modified 

• logs in or out 

• has a login failure 
 

• Name of the user 

• User ID within Inova LightLink 

• Timestamp of event 

• User that initiated the event (if applicable) 

• Type of event (creation, deletion, privilege or  
access rights modification, login, logout, or login 
failure)  

•  Any textual explanation to accompany the event 
(optional) 
Table 4 
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5.5. License Report 

Upon request, LightLink Auditor will open a report of LightLink usage 
compared to licensed features.  The License Report is generated from the latest 
snapshot in the audit database; as such, you may want to generate a snapshot 
before generating a license report to get the most current usage.   

To view the report, select View License Report from the Auditor context menu. 

Administrator will launch an application to view the license report (e.g., Excel or 
a text viewing application such as Word Pad, depending on the computer file 
mapping setup).  The license report is a comma-separated values list written to 
the file, named “LL_license_report.csv”, in the folder, “Server\srvcfg\audit”, 
within the LightLink installation location.  Figure 33 shows an example License 
Report, as viewed in Excel. 

 

Figure 10 

5.6. Desktop AutoSweep 

The Desktop AutoSweep feature automatically reports and removes from the 
Output Channels any registered Desktop Presenter users that have not logged in 
for a specified period of time.  The Desktop AutoSweep deletion process will 
remove the registered user, all virtual displays associated with the user, and all 
message activities associated with the user; it will also remove the user and 
associated virtual displays from any Display Groups of which it was a member. 

This feature applies only to Desktop Presenter users; it does not affect TCP/IP Displays, 
or other types of output devices.     
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Each Desktop Presenter Output Channel must be separately configured with a 
specific number of days of inactivity after which Desktop users are considered 
expired.   

Specifying zero for the number of days (the default value) for an Output Channel 
turns off this feature for that Channel. If you enter zero for the Number of Days, 
then the Evaluation Settings are not implemented for that Channel. 

Upon a desktop client login, LightLink will register a ‘last logged in’ timestamp 
in the Inova database. When enabled, the autosweep tool checks once a day for 
desktop clients that have a last logged in timestamp in excess of the number of 
days defined in the autosweep interface. The last logged in timestamps are not 
reset when settings are changed in the autosweep interface, so any clients 
already in excess of the defined value will be purged upon next execution of the 
‘report and remove’ process. The autosweep operation runs by default at 5:00 
a.m. every day, but an Administrator user can invoke it explicitly to run on 
demand via the Perform evaluation now option in the Auditor properties dialog. 

Desktop Autosweep has a VIP list capability so that a specified set of occasional 
Desktop Presenter users will not be removed for lack of use. The VIP list is 
specified in the file, %ProgramData%\LightLink\vip_device_list.csv.  This file 
basically follows the csv format (comma-separated values), specifying the 
usernames of those Desktop Presenter users not to be removed, with optional 
comments specified by the semi-colon character.  Desktop Presenter users who 
are specified in the VIP list and are expired will not be removed by Desktop 
Autosweep; they will be reported in the i_auditserver log as separate log entries 
before the Desktop Autosweep report (see Figure 11). 

Note that a reasonable option would be to create a separate OCM, and not have 
any of its users removed.  With this option, a LightLink administrator can put all 
the VIPs into a separate OCM and set its Expiration Value to zero (0).  The VIP 
list is good for a quicker method of adding a user to the do not remove list.  Using 
the VIP list feature, the designated VIP user doesn't lose any messages, whereas 
if that user is put into a new OCM the administrator has to make sure the user is 
added to the right Display Groups and receives the right messages. 

The Desktop AutoSweep report can be found in the i_auditserver log file.  

Refer to Figure 11 to see the log from a report only operation.  This log lists five 
expired desktop users found in the VIP list and six expired desktop users that are 
not in the VIP list; the six not in the VIP list will be removed.   
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Figure 11 

The log in Figure 12 is from a report and remove operation and shows the six 
devices that have been removed.   

 

Figure 12 

Note: When a large number of expired users is removed in one sweep, it can take 
significant system resources and clock time to complete.  For example, in our test system 
with 500 expired users out of 1000 total users, and 230 messages (4000 activities), it took 
4 minutes on a quad-core CPU; all remaining users continued playing their messages 
correctly and the supervisor users on the server were responsive.  Inova Solutions 
recommends performing a Desktop AutoSweep with actual deletions at a time when 
business activities are lowest (e.g., at the scheduled time of 5:00 a.m.). 
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6. Client Manager  

6.1. Overview 

Client Manager handles all of the client connections for a LightLink host.  
Connections are made to the Client Manager over the TCP/IP protocol.  Client 
Manager provides services to LightLink client programs.  These services include 
security checking via client login, user profile management, service location in 
the distributed Inova LightLink system, and command routing between 
LightLink components. 

Types of clients connecting to the Client Manager Server (CMS) include: 

• System Manager 

• Message Editor 

• Administrator 

• Marquee 

• DataLink 

• TaskLink 

6.2.  Client Manager Context Menu   

Table 5 describes the Client Manager context menu items. 

Menu Item Explanation 

Add to View Window Add this to an open view window 
Start Component Start the selected component 
Stop Component   Stop the selected component 

Table 5 
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7. Supervisor Database Connection 

This node has no configuration; it represents the service that connects Supervisor 
applications to the LightLink database. The LightLink middleware applications, 
including Administrator and Security Manager, connect directly to the LightLink 
database and do not use this connection service. 
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8. External Input Manager  

8.1. Overview 

The External Data Source Manager provides a mechanism to connect to a data 
source for which LightLink doesn't provide a specific interface.  In general, one 
configures an EDSM to connect to such a data source, and then one connects a 
LightLink custom DSM to the EDSM to bring the data into LightLink.  Contact 
LightLink Technical Support for assistance in configuring an External Data 
Source Manager. 

8.2. Adding a New External Data Source Manager 

To add a new External Data Source Manager (EDSM): 

1. Open the New External Data Source menu item on the desired Input 
Manager node in Administrator.   

2. Select the type of EDSM to add.  A Properties dialog will appear for 
configuring the EDSM.   

3. On the Properties dialog, give the EDSM a meaningful name or accept the 
default name.   

4. Next, select the configuration ini file for the EDSM by clicking the Browse 
button or merely entering the name of the file in the available text box.  

The ini file must reside in the exe directory of the Inova LightLink installation.   

To edit the configuration ini file, click the Edit button to open an edit 
window containing the file content.  No default name for an ini file will be 
assumed. 

5. Once the EDSM configuration is finished, select OK on the Properties 
dialog to complete the configuration 

The EDSM server can be configured for any of the following data sources: 

• Aspect RTB  

• Genesys GIS 

• Interactive Intelligence  

• Avaya Aura 

• Nortel Symposium  

You can change the EDSM properties at any time by selecting Properties from 
the EDSM context menu. 
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8.3. External Input Manager Context Menu 

Table 6 describes the External Input Manager context menu items. 

Menu Item Explanation 

Add to View Window Add this to an open view window 

Start Component Start the selected component 

Stop Component   Stop the selected component 

Delete Delete the selected component 

Properties Open the Properties dialog 
Table 6 

From the LightLink Administrator popup menu of a given EDSM GUI, the 
EDSM can be shutdown and launched by clicking the Stop Component or Start 
Component menu items respectively.  The LightLink system tree view icon for 
the EDSM will reflect whether or not the EDSM is running.  The External Input 
Manager node can also include multiple external data sources, if so configured.  
Each data source can be started and stopped.   

In addition, LightLink and external sources will each have options from the 
context menu:  connect and disconnect.   

 

Figure 13 
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9. Input Manager  

9.1. Overview  

LightLink data source connections provide the LightLink interface to your real-
time data. A data source connection is the communications link between a real-
time data source and the LightLink system.  You make these connections via the 
Input Manager component. 

The Input Manager establishes and monitors the connection between your data 
and LightLink, thereby providing a real-time flow of raw data into the LightLink 
system. Multiple data sources can be configured via an Input Manager; each one 
is known as a Data Source Manager (DSM). Multiple Input Manager components 
can be configured in the LightLink system to distribute the input data processing 
load among multiple servers. 

Once the raw data has been captured, you can use System Manager and Message 
Editor to direct the data to specific output destinations of your choice, once those 
destinations have been configured in Administrator. You can also monitor the 
data and overall system health using these applications. 

9.2. Adding a New Data Source 

Though there are a number of different data source options, the process for 
adding and configuring a new data source is the same for each type of data 
source.   

To add a new data source, right click on Input Manager and select New Data 
Source Connection from the context menu. 

The New Data Source dialog (Figure 14) appears with the currently-licensed data 
sources for your system displayed.  Choose a data source type and the data 
source properties dialog will open.  From here, you can set the configuration for 
the data source.  Refer to the specific data source sections below to see how to 
configure each one. 

 

Figure 14 
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9.3. Data Source Connection – Context Menu 

Once you have created a data source, you can access a number of options from 
its context menu.  To access the data source context menu: 

1. Expand the Input Manager node to show the configured data sources. 

2. Right click on the desired data source.  The Data Source Context menu 
appears.  Table 7 describes the context menu items. 

Menu Item Explanation 

Add to View Window Add this data source to an open window 

Begin Diagnostics    Start diagnostic logging in Log Viewer 

End Diagnostics    Stop logging to Log Viewer 

Login Execute Login to the Data Source 
Connection 

Logout    Execute Logout of the Data Source 
Connection 

Delete    Delete the selected Data Source Connection 

Properties    This option allows viewing and, if 
configuration permissions are enabled, 
editing data source properties 

Table 7 

Note that the diagnostics are viewed in the data source .ivt log using Log Viewer.  Refer 
to the LightLink Log Viewer Solution Guide for more details. 

9.4. Input Manager – Context Menu   

The context menu is content sensitive and will have different items depending on 
the tree nodes selected.  Refer to Table 8 for more details about the context menu. 

Menu Item Explanation 

Add to View Window Add Input Manager to an Administrator 
window 

New Data Source Connection Add a new external data source connection 

Start Component Start the selected component 

Stop Component   Stop the selected component 

Properties Modify the diagnostic level and the 
expired/canceled messages interval settings 

Configure Contracts Configure contracts   
Table 8 
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9.5. Input Manager Properties 

With the Input Manager Properties dialog, you can change the logout timeout 
and the status report interval.  You can also adjust the advanced properties 
settings on the advice of Inova personnel. 

To configure the Input Manager Properties Settings options:  

1. Complete the following fields from the Properties dialog:  

• DSM Logout Timeout (seconds) - The number of seconds allotted to a 
Data Source Manager (DSM) to logout.  If the DSM has not logged out 
in that time, its connection to the data source switch is abruptly cut.  

• DSM Status Report Interval (seconds)  The interval at which each 
DSM reports its status on the Info Bus 

2. If you wish to access the advanced properties, click on the Advanced 
button.  The Advanced button settings should only be changed on the advice of 
Inova personnel.  

3. Select OK to complete the configuration. 
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10. Data Set Contracts 

10.1. Overview 

Data set contracts provide a mechanism for grouping multiple data items into a 
unit based on a topic name.  All systems that need to know about a unit can use 
the same contract. In a topic-based publish and subscribe environment, the topic 
name is the name of the bus topic by which the data will be available.  The Input 
Manager will send data to this name, and subscribers will receive data on this 
name. 

Data Set Contracts provide a way to bring data into LightLink that will only be 
managed as a set; individual data values acquired in a Data Set Contract are not 
available within LightLink.  For example, a Data Set Contract can be set up to 
acquire data from a data source and exported to a database where it can be re-
acquired in a different format by another LightLink data source manager (DSM) 
that then provides the data as distinct data fields. 

From the Data Set Contract Properties screen, you can Edit, View, Delete, and 
create a New Contract. You can also Import or Export files specifying Data Set 
Contracts details.  See the following sections to see how to edit, view, delete, and 
create a new contract. 

10.2. Creating a New Contract 

Each Data Set Contract is identified by a unique Topic Name.  

The basic rules for creating a Topic Name include: 

• Topics must always begin with the separator character, which is a 
forward slash character (/).  

• A topic may have one or more components, each separated from the 
others by the separator. 

• Some examples of valid topics include “/root/deva/teflon”, 
“/server_3/data_sources/NT_Max” and 
“/dow/stocks/IBM/mainframes”.  

• Some examples of invalid topics include “dell/web”, 
“/fox/trot/alpha/” and “/canton//news/current”. These examples 
are invalid because the first does not start with a separator (it is 
considered non-rooted), the second has a trailing separator and the 
third has two separators in a row with no component between them 

To create new Data Set Contracts from the Data Set Contract Properties dialog: 

1. From the Data Set Contract Properties dialog, select New Contract. 
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2. The Define Contract Properties dialog appears.  There are three tabs to 
complete when creating a new contract: Header, Attributes, and 
Validation Checks.   

3. Complete the fields on the Header tab of the Define Contract Properties 
dialog.    

4. Click on the Attributes tab of the Define Contract Properties dialog and 
click New. 

The Attribute Information dialog appears.  Attributes displays the list of 
data values that will be packaged together and published as a single 
entity.   

Complete the following fields:   

• Name - This is probably the most important attribute property.  This 
name will be the identifier that components use to reference the 
data.  Publishers will fill data sets based on this name, and subscribers 
will retrieve data from a data set based on this name.  The name 
attribute allows for name based mapping between subsystems and 

data being moved on the bus.   

• Data Type - The data type identifies the expected type for this 
attribute.  It is possible the publisher could provide the data with a 
different type.  Subscribers will either use the published type, or 
transform the data to this type if necessary for their operation.  This 
type will be used in generating the default value.   

Types are based on those supported by the Expression library and 
include:  INT16, UINT16, INT32, UINT32, DOUBLE, CHAR, STRING, 
BOOL, DATE, TIME, DATETIME, and REALTIME 

• Comment (optional) - description or comment about the purpose or 
usage of this attribute. 

• Maximum Length (optional) - the maximum amount of data that is 
meaningful in this attribute.  Generally this only applies to strings, but 
could also specify the number of significant digits in numbers. 

• Default Value - value that will be returned automatically if no value 
was provided in the publication.  The value will be typed with the 
specified Data Type. 

Time values should be specified as: hh:mm:ss.  By default hours 
should be 0-23.  It is also valid to specify the hours as 0-12 and put 
either am or pm after the time value. 
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Date values must be specified as mm/dd/yyyy for proper parsing. 

DateTime values must be specified with the date first, a space 
character, and the time last. 

RealTime values are specified as the amount of time to offset from the 
current time.  The time can be formatted as hh:mm:ss, mm:ss, or as just 
seconds.  The offset can be negative to specify times before the current 
time, or positive for times after the current time. 

• Pack Default Values – Check this box to specify whether the publisher 
should pack default values for submission.  Normally default values 
are resolved at the subscriber and are not included as part of the 
transmission.  If this value is specified as true, then default values will 
be generated at the publisher and included in the transmitted data.  

Select OK to complete the configuration.  

5. Click on the Validation Checks tab to see the Validation Checks screen. 

Validation checks allow for one or more checks to determine whether the 
data set is considered valid.  Validation checks are specified in the form of 
an expression that returns a true or false result.  The attributes in the 
publication can be used within the expression through named references. 

To create a new validation check, select New.  The Data Field Expression 
dialog appears.  Create an expression that returns a boolean (true/false) 
result.   

6. The contract data values will only be published if the expression result is 
true when a new set of data values are received by the system. 

See the Data Field Expression Solution Guide to learn how to create data field 
expressions. 

Select Save to complete the configuration.   

7. Once you have completed the fields on the three tabs, select OK to 
complete the configuration. 

10.3. Viewing a Data Set Contract 

To use the View button to view existing Data Set Contracts: 

1. Select Input Manager > Configure Contracts to open the Data Set Contract 
Properties dialog.   

2. Select the contract you want to view.  If there is only one contract, it will 
already be selected. 
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3. Select View Contract.  The Contract Details screen appears. This screen is 
view only.  It is not editable. 

4. Click OK to return to the Data Set Contract Properties screen. 

10.4. Exporting a Data Set Contract 

To export existing Data Set Contracts to a specific folder: 

1. Select Input Manager > Configure Contracts to open the Data Set Contract 
Properties dialog.     

2.  Select the file you want to export.   

3. Select Export.  

4. The Save the Data Set Contract File As screen appears. Locate the folder 
where you want to save the existing .ini file and select Save.  The file is 
saved to the targeted folder.  

10.5. Importing a Data Set Contract 

To import existing Data Set Contracts for editing, viewing, deleting, or exporting: 

1. Select Input Manager > Configure Contracts.   

2. Select Import.   

3. The Select a Data Set Contract File dialog appears.   Locate the folder 
where the existing .ini file is located.   

4. Select Open.  

5. The file opens in the Data Set Contract Properties screen so you can edit, 
view, or delete the contract.  
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11. Managing Data Sources 

Refer to the individual Data Source Installation Guides for more information 
about managing specific data sources.   

11.1. Data Field Naming 

For Middleware versions 5.12 and later: 

LightLink data fields are composed of a group name and a field name, separated 
by a colon.  For many DSMs, the group name is composed of a Table name and a 
Key name separated by a colon.  In such cases, if the group name exceeds the 30-
character limit (including the colon between Table name and Key name), the Key 
name will be truncated to achieve the limit of 30 characters; if the Key name is 
truncated to one character and the resulting group name still exceeds 30 
characters, LightLink will leave the Key name at one character and will truncate 
the Table name to bring the group name down to 30 characters.   

For example, if the table name is "Workgroup_Test_Long_Name" (24 characters)  
and the Key name is "Express" (7 characters), the Key name will be truncated to 5 
characters and the Table name will not be truncated, so that with the colon 
between Table name and Key name, the group name will be within the 30 
character limit. 

The data field name is also limited to 30-characters in size; if it comes in to 
LightLink larger than that, it will be truncated to 30 characters.   

Both the group name and the data field name cannot contain these characters:  

* ? # % [ ] ^ + / & ' ( ) " : , . 

If any disallowed characters are present when the data field comes in to 
LightLink, they will be removed and the data field name will be created without 
them. 

The Data Source Manager log will record any time that these restrictions are 
encountered, the group and field name size limits, and the disallowed characters.  

11.2. Configuring Data Sources  

The information below is generic and may not apply to all data sources.  To 
configure a new Data Source: 

1. Right-click the Input Manager icon to open the context menu. 

2. Select New Data Source Connection. 

3. From the New Data Source dialog, select a Data Source type.   
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4. Select OK.   

5. The selected Data Source Properties dialog appears. The General tab will 
be pre-selected; select if it is not.     

The Name, Preferred ID, and Hostname may be pre-populated. Some fields may 
be grayed out, which means they cannot be edited.   

You can edit any fields that are not grayed out.   

6. Select the Connection tab from the Properties dialog.  

7. Complete the data source connection protocol and settings on this dialog.   

Note that the COM port selection is exposed if you are configuring a serial port 
on the host PC.  The COM port setting must be a valid serial port number 
(e.g., 1) and must be the physical or logical serial port to which your data 
source is connecting on the host. 

8. Select the Settings tab from the Properties dialog and complete the fields.  
Not all Data Source Dialogs are exactly the same. 

9. Select the Advanced button on the Settings tab to view the advanced 
options.  The Advanced button settings should only be changed on the advice of 
INOVA personnel. 

Inova strongly recommends that you make changes to these settings only upon 
the advice from or with the assistance of an Inova technician.  Please call Inova for 
customer service and technical support. 

10. If you need to allow secure remote access, select the SSH tab on the 
Properties dialog.  Refer to Section 11.2.1 for further detail about SSH.   

11. Select OK to complete the configuration. 

11.2.1. SSH Configuration  

Secure Shell (SSH) allows secure remote access for those who need it by 
employing public key encryption. To enable SSH: 

1. Select the SSH tab on the Properties dialog and then select the SSH 
checkbox.  

2. Complete the data source SSH options on this dialog. You must at least 
provide the correct Login ID and Password parameters. 

The Switches field can be blank if no switches are needed for the SSH 
connection.  If switches are needed to get a proper connection, some 
possible switches are listed in Table 9. 

Switch Explanation 
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-X -x  enable / disable X11 forwarding 
-A -a  enable / disable agent forwarding 

-t -T  enable / disable pty allocation 

-1 -2  force use of particular protocol 
version 

-4 -6 force use of IPv4 or IPv6 

-C  enable compression 

-i key  private key file for authentication 

-s  remote command is an SSH 
subsystem (SSH-2 only) 

-N  don't start a shell/command (SSH-2 
only) 

Table 9 

3. Return to the Connection tab.  Complete the following on this tab: 

• Select TCP/IP Connection for the protocol type.  

Selection of SSH changes the way the Connection tab address specification 
works, which can be a bit misleading. 

• In the Hostname or IP address field, enter the hostname or IP address 
of the system to which you wish to make the SSH connection.  

• Enter the port number at which the LightLink DSM will receive the 
data from the data source 

The Listening port for the SSH configuration is not the SSH port on the 
remote address (the address/hostname you entered in the Hostname or IP 
address field). It is the port on the LightLink server (the one hosting the 
DSM) for the tool used to wrap SSH communications to connect to the 
DSM. It must be unique and unused on the Input Manager server 
hosting the DSM. It is best to use a high-numbered ephemeral port 
number, 49152 through 65535. 

These changes to the Connection tab are an override of the labeled configuration 
elements on that tab. If you are configuring more than one SSH DSM on this 
Input Manager host, it is important that each such DSM have a unique 
port number not already in use by another DSM or other service running 
on the Input Manager host. 
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12.   Object Bus Configuration 

12.1. Overview 

Object Bus Configuration allows advanced users to configure alternate bus 
segments for distributing the object bus load.  This function is rarely needed; 
please contact Inova technical support for additional help configuring object bus 
properties.    
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13. Site Monitor  

13.1. Introduction 

The LightLink Site Monitor allows Inova Solutions customers who have 
purchased our cloud solutions to activate an uplink that will send real-time 
contact center data to the Inova Solutions cloud site. 

13.2. Purpose 

Inova Solutions is building real-time contact center dashboard products to 
handle a wide array of information, perform more analysis, and present 
reporting in a web browser.  Customers who purchase cloud solutions can 
optionally activate the Site Monitor uplink in the premises LightLink 
middleware server that will send real-time contact center data to our cloud based 
data center.  We will offer web dashboards served from that data center in a 
variety of formats and user options so that contact center managers and agents 
have access to the best information for managing their centers, including access 
to messaging and historical data.  Hosting the web applications in the cloud will 
allow Inova to seamlessly provide real time data to mobile devices as well. 

13.3. Data Security 

We are aware that contact center data is confidential. The data transferred to and 
from the cloud site is encrypted via HTTPS. Only a LightLink Administrator can 
use Site Monitor to authorize real-time data transfer to the cloud. 

13.4. Internet Access 

The premises LightLink server will need persistent access to the 
InovaSolutions.com and InovaSolutionsData.com internet domains and 
associated subdomains to ensure real-time data updates. 

13.5. Site Monitor Context Menu   

Table 10 describes the Site Monitor context menu items.  

Menu Item Explanation 
Add to View Window Add Site Monitor to an Administrator window 

Start Component Start the selected component (it will try to restart 
itself if found to be off) 

Properties Turn on or off the upload of LightLink data to the 
Inova Solutions cloud site 

Table 10 
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13.6. Configuring Site Monitor  

The only configuration point for Site Monitor is to turn on/off the sending of 
LightLink data to the Inova Solutions Cloud Site.  You can also view the Inova 
Solutions’ Terms of Service by clicking on the link in the Properties dialog.   

To access the Site Monitor Server Properties Status Monitor options (Figure 15): 

1. Select Site Monitor > Properties. 

2. Check or uncheck the Send Data to Inova Cloud box to activate or deactivate 
the sending of LightLink data to the Inova Solutions Cloud Site. 

3. Select OK to complete the configuration. 

 

 

Figure 15 
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14. Output Manager 

The LightLink Output Manager is responsible for starting and stopping output 
channels and for sending device connection requests and messages to active 
output channels. 

14.1. Overview 

LightLink Output Channels send real-time data and messages to any type of 
output device that the LightLink system supports (e.g, LED Displays, Inova 
Desktop Presenter Clients, email output, and Database Publisher output).  The 
Output Manager is used to create and modify those connections.   

Output Manager interfaces with the LightLink Object Bus, the Data Directory, 
and other LightLink system components to manage the channels and messages, 
and to publish channel status. 

It may be deployed: 

• On the same machine as the other LightLink server components. 

• On a separate machine that is reachable from the Clients via some sort 
of network connection. 

More than one instance of the Output Manager component may exist on the 
network, allowing the processing load to be distributed.   

Some device connections require separate licenses from Inova. 

14.2.  Creating Output Channels  

You must have configuration permissions to create an output device connection (see 
Section 2.1). 

To create new Output Channels,  

1. Choose New Output Device Connection from the Output Manager 
context menu.   

2. Select the type of Output channel you want from the New Output Device 
Connection dialog. 

3. The Properties dialog for the output device you selected appears.  The 
dialogs will vary depending on the device selected.  

Complete the dialog options for the output device. 

4. Select OK to complete the configuration.   
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Output Channels are based on the types of devices available, which include: 

• Inova TCP/IP Displays (Inova OnTrack® displays) 

• Inova Desktop Presenter Clients: 

− Inova Marquee Clients 

− Inova DataLink Clients 

− Inova TaskLink Clients 

• Database Publisher Output 

• XML Publisher Output 

• Email Output 

• Inova TCP/IP Displays - Encrypted  (Inova OnAlert® displays or 
Simplex® TrueAlert® displays) 

• AMS LED Displays 

Refer to the following Sections 21 – 18 for details on the configuration properties 
of the various types of Output Device Connections. 

14.3. Configuring Output Manager Properties 

To configure the Output Manager Properties: 

1. Complete the following fields from the Output Manager Properties dialog: 

• Send Date and Time Interval (seconds) - time, in seconds, after which 
Inova LightLink resends the date and time 

• Status Publish Interval (seconds)  - time, in seconds, between status 
reports 

2. To configure the advanced properties, click the Advanced button on the 
Properties dialog.  Only a knowledgeable technician should access the Output 
Manager Advanced Options. 

Complete the following field in the Output Manager – Advanced dialog: 

• MinSystemLogInterval - how often, in minutes, a given 
system_event.log message is allowed to be printed.  

If the same system_event.log message is generated two or more times 
within this amount of time, only the first will be printed. Some messages 
may override this setting.  

3. Select OK to complete the configuration.   
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14.4. Output Manager Context Menu 

Table 11 describes the Site Monitor context menu items.  

Menu Item Explanation 

Add to View Window Add to an Administrator window 

New Output Device Connection Add a new output device connection 

Start Component Start the selected component 

Stop Component   Stop the selected component 

Import OCM Import a new output channel manager 

Properties Open the Properties dialog 
Table 11 
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15. Inova TCP/IP Displays 

15.1. Overview 

The Inova TCP/IP Displays output channel type allows LightLink to connect to 
Inova OnTrack® LED displays manufactured by Inova Solutions®, and thereby 
to display real-time data and messages on those displays.  The Inova TCP/IP 
Displays support multi-region, multi-page messages that can contain data fields 
that are updated with new values in real-time.  The Inova TCP/IP Displays OCM is 
not compatible with OnAlert display firmware; it is only compatible with OnTrack 
display firmware 1.1.11 with update 1.2.39 applied. 

15.2. Configuring Inova TCP/IP Displays Output Properties  

The following steps detail how to configure the Inova TCP/IP Displays Output 
Properties: 

1. Select Inova TCP/IP Displays from the New Output Device Connection 
dialog. 

2. Select OK.  

3. The Inova TCP/IP Displays Output Properties dialog appears.  Select the 
General tab. 

Complete the following Inova TCP/IP Displays Output General tab 
options:  

• Name - name of this OCM, which appears in the LightLink system tree 
view.  The default is Database Output Connection. 

• Server ID - name of the Inova LightLink system server of which this 
OCM is a part. 

• Preferred ID - numeric ID assigned to this output channel.  The system 
normally assigns this value, but the user can override the assignment 
at initial configuration. 

• Remote Host - name of the host this channel will reside on.  If 
Administrator is in Host View this will be disabled and show the host 
that is being configured on.  If Administrator is in global view this will 
present a list of the hosts the channel can be created on. 

• Disable – If checked the connection is disabled and all devices will be 
inactive. 

• Add Devices – Allows the configuration of new devices. 

• Delete Devices - Allows the deletion of devices. 
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The Add Devices and Delete Devices buttons appear after you have created and 
reopened a connection to edit it. 

4.  Select the Connection tab from the Properties dialog.  Enter the 
connection port, hostname or IP Address, and listening port on the Inova 
TCP/IP Displays Connection tab. 

The Listening Port field specifies which particular TCP/IP port number 
will be used by clients to connect to the Inova LightLink Server. A unique 
listening port number must be assigned by your network administrator 
for use by the Inova LightLink system. 

This Listening Port number must be a decimal number in the range 0 to 
32767, excluding those port numbers that are in use by network services. 
For more information, consult your network administrator. 

5. Select the Default Display Settings tab from the Properties dialog.  
Complete the following Inova TCP/IP Displays Default Display Settings 
tab options: 

• Time Between Commands (ms) - minimum amount of time in 
milliseconds that LightLink will wait after sending a command before 
it sends another command.  

• Data Field Update Interval (ms) - rate in milliseconds at which Inova 
LightLink sends data field updates.  The range is 500 to 60,000.   

• Response Timeout (ms) - time in milliseconds that Inova LightLink 
will wait for a Display to respond to a query command before timing 
out and reporting an error.   

• Automatic Query Interval (ms) - time in milliseconds that Inova 
LightLink will wait between sending status queries to Displays to 
verify proper operation of the devices.  The range is 60 to 3,600.   

6. Select the Monitor Connection tab from the Properties dialog.  Complete 
the following Inova TCP/IP Displays Monitor Connection tab options: 

• Enable - Select to configure and enable the connection. 

• Connection port - Only TCP/IP Connections are allowed any more. 

• Hostname or IP Address - Enter the hostname or IP address of the 
computer on which the Output Manager for this channel is running. 

• Listening Port - Specify the listening port – any port number is 
allowed. 
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7. Select the Settings tab from the Properties dialog.  Only the Direct Channel 
Type is provided at this time; the default value of 60 seconds for Cast 
Interval is usually sufficient.   

8. Select OK to complete the configuration. 

15.3. Adding Devices  

Once you have created a new output device for Inova TCP/IP Displays Output, 
the Add Devices option becomes available from the General dialog. 

1. Select the General tab from the Inova TCP/IP Displays Properties dialog. 

2. Select Add Devices. 

3. The Inova TCP/IP Display Properties dialog appears.  Select the Address 
tab.  Enter the display ID Address, discovery port, and preferred ID in the 
Inova TCP/IP Display Properties Address tab. You can also select Use 
Default Discovery Port to use the default settings.  If un-checked, then you 
must enter the port number. 

4. Select the Settings tab and complete the Inova TCP/IP Display Properties 
Settings tab options:  

• Time Between Commands (ms) - the minimum amount of time in 
milliseconds that Inova LightLink will wait after sending a command 
before it sends another command.  

• Data Field Update Interval (ms) - rate in milliseconds at which Inova 
LightLink sends data field updates.  The range is 500 to 60,000.   

• Response Timeout (ms) - time in milliseconds that Inova LightLink 
will wait for a response from a Display before timing out and 
reporting an error.   

• Automatic Query Interval (ms) - time in milliseconds that Inova 
LightLink will wait between sending queries to output devices to 
verify proper operation of the devices.  The range is 60 to 3,600.      

5. Select OK to accept the configuration changes. 
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16. Inova Desktop Presenter 

16.1. Overview 

The Inova Desktop Clients output devices display real-time data and messages 
on Microsoft Windows workstations.  These software applications are available 
in the Inova Desktop Presenter product suite. 

• Inova Marquee® Clients 

• Inova DataLink Clients 

• Inova TaskLink Clients 

To connect clients of these various types to the LightLink system, create an OCM 
for each specific type of client desired.  Multiple OCMs of each type can be 
configured on any of the servers in the LightLink system. 

When upgrading from an earlier version of LightLink (Server version 5.7.327.2 or 
earlier), any previously configured LightLink Desktop Clients OCMs will continue to 
exist with the clients configured at the time of the upgrade.  Clients can be added or 
removed; no new OCMs of the “LightLink Desktop Clients” type can be created. 

There are four tabs to complete for LightLink Desktop Client Properties: General, 
Connection, Address Ranges and Settings.    

16.2. Configuring Inova Desktop Presenter Channels  

To configure an Inova Desktop Presenter Channel: 

1. Select Output Manager > New Output Device Connection. 

2. The New Output Device Connection dialog appears.  Select the particular 
type of Desktop Client OCM required (for this example, we will choose 
Inova Marquee Clients). 

3. Select OK. 

4. The OCM Properties dialog appears.  Select the General tab. 

The OCM Name, Server ID, Preferred ID, and the Hostname of the (remote) PC 
on which the Output Manager for this connection resides are pre-populated. 
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Complete the following General tab options: 

• Name - name of the Output Channel (OCM). 

• Server ID  -  the ID number of the Server 

• Preferred ID - allows you to specify the preferred ID; however, you 
should generally leave the Preferred ID at the default value provided 
by the system.  If the default is changed, ensure that it is a unique 
value. 

• Host - name of the host on which the Output Channel is managed. 

• Disable - select the check box to stop OCM processing; in this state 
clients are disconnected and do not receive messages or data field 
updates.  Clients will automatically reconnect when the OCM is 
enabled by unchecking the Disable checkbox. 

• Add / Delete Devices - allow you to add and/or delete output devices 
from the channel. These buttons are only available after you create a 
connection.   

5. Select the Connection tab from the Properties dialog (Figure 16). 

 

Figure 16 
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Complete the following Desktop Clients Properties Connection tab 
options: 

• Connection Port - Depending upon the type of connection you are 
establishing, one or more Connection Port options will be displayed on 
the drop-down menu.  There are three types of connections for Inova 
Desktop output channels: TCP/IP Connection, TCP/IP Multicast, and 
TCP/IP Broadcast.  The three connection types have different sets of 
properties on the Connection tab. 

− TCP/IP Connection – This connection type can serve the Inova 
Marquee, Inova DataLink, and Inova TaskLink clients.  It makes a 
direct connection to each client for data transfer.  On the connection 
tab, specify the following: 

▪ Hostname or IP address: the name or address of the host on 
which the Output Channel is managed. 

▪ Listening port: the number of the port on the specified host 
at which the output channel will listen for connection 
requests; must be unique on the output channel server. 

− TCP/IP Broadcast – This connection type can serve all five of the 
Inova Desktop clients.  It broadcasts messages and data to the 
clients rather than making a direct connection.  The broadcasts are 
limited to the subnet on which the output channel resides, unless 
the “unicast” mode is configured (where the begin and end address 
are the same).  On the connection tab, specify the following: 

▪ IP address Range 

• Begin: the starting IP address of the subnet (e.g., 
125.5.12.0), or the unicast address (e.g., 125.5.12.78). 

• End: the ending IP address of the subnet (e.g., 
125.5.12.255), or the unicast address (e.g., 125.5.12.78). 

• Send Port: the port at which clients will listen for 
data; must be unique across all broadcasting output 
channels running against the same subnet. 

▪ Receive Address 

• Hostname or IP address: the name or address of the 
host on which the Output Channel is managed 
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• Receive port: the number of the port on the server to 
which the clients will send connection requests; must 
be unique on the server host. 

− TCP/IP Multicast – This connection type can serve all five of the 
Inova Desktop clients.  It sends messages and data to the multicast 
group with which clients register interest, rather than making a 
direct connection.  The combination of IP Address and Send Port 
must be unique for these messages and data.  On the connection 
tab, specify the following: 

▪ Multicast Group 

• IP Address: the IP address of the multicast group, in 
the range 224.0.0.0 to 239.255.255.255. 

• Send Port: the port at which clients will listen for 
data. 

▪ Receive Address 

• Hostname or IP address: the name or address of the 
host on which the Output Channel is managed 

• Receive port: the number of the port on the server to 
which the clients will send connection requests; must 
be unique on the server host. 

You can change the type of connection for an OCM after its initial 
configuration; however there are some caveats: 

▪ When changing to or from the TCP/IP Connection type to 
another connection type, all of the connected clients must be 
restarted 

▪ When changing to the TCP/IP Connection type for an OCM 
that was upgraded from a previous version of LightLink 
(5.7.327.2 or earlier), that OCM can only have one entry for 
each registered user (i.e., delete any extra entries before 
changing the connection type). 

6. Select the Address Ranges tab from the Properties dialog if you want to 
restrict the IP addresses from which clients can connect to this channel.  
Refer to Section 16.3 for more information about the optional Address Ranges. 

Complete the following Address Ranges tab options: 
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• When selecting either the Add tab or the Edit tab, the IP Address 
Range dialog appears.  Enter the starting and ending IP Addresses for 
your range. 

• You can select a configured address range and click Edit or Delete, to 
perform those actions as needed. 

Select OK to accept your changes and return to the Properties dialog. 

7. Select the Settings tab from the Properties dialog. 

Complete the following Desktop Clients Properties Settings tab options: 

• Don’t Report Message Errors for Offline Users – check this box to 
avoid having message status in the error state because of registered 
users that are not connected. 

• Time Between Commands (ms) - amount of time in milliseconds that 
Inova LightLink will wait after sending a command before it sends 
another command. 

• Data Field Update Interval (ms) - rate in milliseconds at which Inova 
LightLink sends data field updates.  The range is 500 to 60,000. 

•  Device Status Timeout (ms) - amount of time in milliseconds that 
Inova LightLink will wait for a response from a display before timing 
out and reporting an error.  Inova recommends that the default Timing 
Values be accepted unless there is good reason to change them.      

• Number of Rows - number of LED rows in the Marquee client. 

• Number of Columns - number of LED columns in the Marquee client.  

8. Select OK to complete the Output Channel configuration. 

16.3. Address Ranges Tab 

This properties tab applies only to the TCP/IP Multicast and TCP/IP Broadcast 
connection types. If this tab contains no entries, then anyone whose IP Address is 
compatible with the multicast address or subnet specified on the Connection tab 
of the Properties dialog may connect to this Output channel.  If you have only 
one channel total, or only one output channel that is compatible with any given 
user, then it is best to leave this tab blank. 

If you have more than one output channel that is compatible with a given user, 
then the possibility exists that they might connect to one channel at one time and 
some other channel at another time.  To prevent this ambiguity, specify non-
overlapping Address Ranges, one for each output channel of the same type, such 
that each user's computer is in only one of the address ranges. 
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For example:  

• Channel A has Address Range 11.4.56.0 - 11.4.56.120 

• Channel B has 11.4.56.121 - 11.4.56.255 

Any given user will fall within only one of the specified ranges and therefore will 
get connected with Inova LightLink on one output channel only.  

16.4. Adding Devices  

For the five Inova Desktop OCM types, authorized client connections (also 
known as Devices on the Channel) are specified in advance of the clients 
attempting to connect.   

This is true regardless of the configured connection type (TCP/IP Broadcast, 
TCP/IP Multicast, and TCP/IP Connection).  Specify the allowed clients for each 
OCM in the form of “Domain Name\User Name” for each account under which 
the application will be run.  

Only one client will be allowed at any given time for each entry in the OCM.  If 
multiple clients on a given OCM will be run under the same user account at the 
same time, one can differentiate each such use with a unique name modifier 
parameter that can be specified for each type of client. The unique name modifier 
is added to the allowed client names for the OCM and on the command line for 
starting the client application (refer to the client user guide for more details). 

To enter allowed client names for the OCM, open the Add Devices dialog after 
creating the OCM.  You can reach this dialog either through the context menu 
(right clicking on the device node) or through the OCM properties dialog 
(Output Manager > LightLink Desktop Clients > Properties > Add Devices) 

The Add Desktop Devices dialog opens.  Enter a single allowed client name or 
multiple allowed client names at the same time.  Each name is of the form 
“MyDomain\MyUserAccount:name-modifier”, where “:name-modifier” is 
optional.  Separate each allowed client name with commas or enter them on 
separate lines; if a name is to include a space character, enclose it in double-
quotes. 
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17. Database Publisher Output 

17.1. Overview 

The LightLink system contains components for Data Capture, Data Analysis, and 
Data Delivery.   

The LightLink system makes its connection to databases via the ADO.net data 
base interface standard.  This allows just about any database to be used to receive 
real time data from the Inova LightLink system as long as it has the proper 
provider or driver.  At the present time this includes Microsoft SQL Server, 
Oracle Database, and Microsoft Access among others.   

Inova LightLink connects to ADO, which then connects to the target database via 
either a native Object Linking and Embedding (OLE) DB provider, or an Open 
Data Base Connectivity (ODBC) driver.  The method using a native OLE DB 
provider is preferred because it presents a newer and more full-featured 
interface.  ODBC is an older method which may not be supported as well in the 
future.  For this reason, an ODBC driver should be used only when no native 
OLE DB provider is available. 

The required OLE DB provider or ODBC driver is configured by the same IT or 
systems administration groups that administer and maintain the target 
database.  These personnel are familiar with their organizations’ best practices 
regarding database interfaces, as well as with the required naming conventions 
and passwords.   

The Inova LightLink system supports the following Data Source types: 

• User Specified 

• OLE DB connection string 

• OLE DB Data Link File 

• ODBC Data Source Name (DSN) 

Of these, preference should be given to the native OLE DB provider or 

connection string.  This will typically be named something like OLE DB 
provider for Oracle.  Note that there is an OLE DB provider for ODBC, but this 
provider carries with it the limitations of the ODBC driver. 

The Database OCM will require the channel (database connection information) to 
be created and configured, before devices (tables or procedures) can be 
added.  After the channel has been defined, then tables or stored procedures can 
be defined for the channel. 
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17.2. Configuring the Database Connection 

To set up a Database Publisher Output: 

1. Select Database Publisher Output from the New Output Device Connection 
dialog. 

2. Select OK.   

3. The Database Publisher Output Properties dialog appears.  Select the 
General tab. This page collects general information that is common to all 
OCMs.   

Enter the name, Server ID, preferred ID, and remote host on the Database 
Publisher Output Properties General tab.  If Disable is checked, all devices 
will be inactive. 

4. Select the Settings tab from the Properties dialog. 

Complete the following Database Publisher Output Properties Settings tab 
options: 

• Connection String - the connection string that specifies how to connect 
to the external database.  

• Connection String Type: 

− User Specified - enables the Connection String edit box, giving the 
user full control to enter the desired connection string. 

− OLE DB Connection String - If clicked, this option changes the 
button on the right side of this panel to Build.  Clicking the Build 
button launches the standard Microsoft OLE DB Data Link 
Properties connection dialog, allowing the user to configure a 
connection string.  Click the Help button to access the Microsoft 
help files. 

− OLE DB Data Link File - If clicked, this option changes the button 
on the right side of this panel to Browse.  Clicking the Browse button 
launches the standard Microsoft data link browser dialog, to allow 
the user to see or browse to existing data link files and tells how to 
create and define new ones. Click the Help button to access the 
Microsoft help files 

− ODBC DSN - If clicked, this option changes the button to Browse. 
Clicking the Browse button launches the standard ODBC Manager 
Browser dialog, allows the user to see all existing configured DSNs, 
and provides the option for creating a new one. Click the Help 
button to access the Microsoft help files. 
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Note: One can create a DSN outside of LightLink; however, on 64-bit 
Windows operating systems, because LightLink Middleware applications 
are still 32-bit apps, the DSN must be set up with the 32-bit ODBCAD 
tool, which is available as Windows\SysWOW64\odbcad32.exe.  

• Update Timeout Interval - maximum time in seconds LightLink will 
wait for an update operation to complete. 

• Disconnect Between Updates – select to cause a connection to the 
database to be made when updates need to occur.  After the update is 
complete, the database is disconnected. If database updates are sporadic, 
the option should be checked. 

If unchecked, the connection to the database is established and held 
indefinitely.  If database updates are frequent, it is recommended that this 
option be unchecked.  

5. Select OK to complete the configuration. 

17.3. Adding New Devices 

Once you have created a new output device for Database Publisher Connection, 
the Add Devices option becomes available from the General tab.   

To access the Add Device option for Database Publisher Output: 

1. Select Add Devices from the Database Publisher Output Properties dialog. 

2. The Create Database Updater dialog appears. 

Refer to Section 17.4 for more information about how to create a new table, use 
an existing table, and use a stored procedure. 

17.4. Creating and Accessing a Table 

Once you have established a database connection, the LightLink system can be 
configured to connect to the database and write real time data into one or more 
tables. To begin this process from Inova LightLink Administrator: 

1. Select Output Manager > Database Publisher Output > New Device. 

2. The Create Database Updater dialog appears. 

There are three options from this dialog:  

• Create a New Table (Section 17.5) 

• Use an Existing Table (Section 17.6) 

• Use a Stored Procedure (Section 17.7) 
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17.5. Creating a New Table 

When Create a New Table is selected from the Create Database Updater dialog, 
the user is defining a new table to be created in the external database.  After the 
table is created, the OCM will update the fields in the new table.   

To complete the process of creating a new table: 

1. Enter the table name in the New Table Name field.  

This specifies the name used for the table in the database.  By default the 
new table will be empty, with no defined columns.   

If tables already exist in the database you can choose to select one as a 
template for the new table.  The column structure from the existing table 
will be copied as the starting point for defining the new table. 

2. Select OK to complete the configuration and go to the Field Mappings.  

Refer to Section 17.8 to see how to complete the Field Mappings screen. 

17.6. Using an Existing Table 

When Use an Existing Table is selected from the Create Database Updater dialog, 
the user wants to send updates to a table that already exists in the external 
database.  This means the table already has a specific set of column attributes.   

To use an existing table: 

1. Select the table name in the Select Table to Use list. 

You will only be able to map values into the existing columns.  New 
columns cannot be added.  A table will only be available for use if it exists 
in the database and is not already in use by another Inova LightLink 
device on this channel. 

2. Select OK to complete the configuration and go to the Field Mappings.  

Refer to Section 17.8 to see how to complete the Field Mappings screen. 

17.7. Using a Stored Procedure 

Select Use a Stored Procedure from the Create Database Updater dialog when you 
want to send updates to an external database via a stored procedure call.  You 
are presented with a list of all the non-system stored procedures in the external 
database.  You are then able to define what values to map into each parameter of 
the stored procedure call. 

To use a stored procedure: 

1. Select the stored procedure in the Select Stored Procedure to Use: list. 
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You will only be able to map values into the existing columns.  New 
columns cannot be added.  A table will only be available for use if it exists 
in the database, and is not already in use by another Inova LightLink 
device on this channel. 

2. Select OK to complete the configuration and go to the Field Mappings.  

Refer to Section 17.8 to see how to complete the Field Mappings screen. 

17.8. Configuring and Maintaining a Table 

After you have established a database connection and named a new table, 
accessed an existing table, or accessed a stored procedure on the Create Database 
Updater dialog, the Create Database Updater dialog appears. 

When you select OK, the Field Mappings Dialog appears.  

After the updater target is defined, a second dialog is presented for you to 
configure the Field Mappings for this updater.  The Field Mappings Dialog is the 
heart of configuring a Database OCM device.  This dialog contains all the column 
and field information for a Database device.  

This Field Mapping Dialog provides a rich interface for configuring the 
information that is written to the database table or sent as parameters to a 
database stored procedure.   

Not every part of the UI is available in all cases.  When configuring a new table, 
all options are available.  When working with existing tables or stored 
procedures, the options are limited. Each operation will specify limitations for 
that operation. 

17.9. Update Options 

1. When you click the Update Options button (Figure 17) on the Field 
Mappings dialog, the Update Settings dialog appears. 

 

Figure 17 

This dialog is used to specify when to perform updates and whether 
updates use the snapshot or historical style.  The read-only edit field 
provides a textual description of the current settings. 

2. Select from the options under Perform Updates: 

• On Reception of Contract Data Set Values - An update will be done 
for every set of data that is received on a Data Set Contract bus 
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topic.  In this mode updates are triggered by the reception of a new set 
of data values.   

Selecting this type also enables the selection of Data Set Contract data 
fields in the Data Field Expressions Dialog when doing field 
mappings.  When data set contracts are used the table will not be 
validated unless this option is selected.  Additionally each row in the 
table must reference one and only one contract.  Multiple fields from 
the same contract are allowed within a row. 

• Periodically - Perform an update on the Update Period interval.  Enter 
a value and select Seconds, Minutes, or Hours with the Update Period 
drop-down list. 

• Periodically if Data Values have Changed - Perform an update on the 
Update Period interval, but only if data values have changed since the 
last update. 

• Periodically based on Conditions -   Perform an update on the Update 
Period interval, but only if one of the conditional triggers is true.  If 
any of the triggers are true, then the entire table will be updated.   

When you select this option, the Conditional Updates Expressions List 
dialog appears.  The dialog will be blank if there are no saved 
expressions available.  The Add be will be active, but not Modify or 
Delete.  Modify or Delete will be available when a saved expression is 
available. 

This dialog allows for the definition of expressions that will trigger an 
update to occur.  A conditional expression has a Boolean result.  If any 
of the events cause a true result, then an update will occur.  All rows 
and values in the table will be eligible for updating, not just the values 
involved in the conditional expression.  Events can be added, 
modified, or deleted. Refer to Sections 17.10, 17.11, and 3  for more 
information about data field expressions. 

3. Select from the two options under Update Method: 

• Overwrite Last Record (Snapshot) - Each update overwrites the 
previous values that were written. 

• Append Values (Historical) – Each update appends a new row of 
values to the table.  This creates a historical collection of data values 
over time. 

These options will not be available for Stored Procedures 

4. Select OK to complete the configuration. 
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17.10. Adding an Expression 

1. Select Add from the Conditional Updates Expressions List dialog. 

2. The Data Field Expression dialog appears.  Complete the Data Field 
Expression box.  Then return to the Conditional Update Expressions List. 

3. Select OK to complete the configuration.   

17.11. Modifying an Expression 

With a saved expression displayed, the Modify button is available.   

1. Select Modify. 

2. The Data Field Expression dialog appears with the values displayed for 
that expression.  Fill in the expression box at the bottom.  Then return to 
the Conditional Update Expressions List. 

3. Select OK to complete the configuration.   

17.12. Maintenance Options 

When you click the Maintenance Options button on the Field Mappings dialog, the 
Maintenance Settings dialog appears. 

 

Figure 18 

This is only available when doing Historical updating for tables.  It is used to 
configure options for limiting table sizes.  The read-only edit field provides a 
textual description of the current settings.  Stored procedures and snapshot 
updating do not support maintenance. 

1. Select one of three options under Condition: 

• If Number of Records Exceeds – The maintenance action will be 
performed if the number of records in the database exceeds the 
configured setting.  Enter a number in the text field. 
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• After Every – The maintenance action will be performed on the period 
specified.  The start of the period is when the Output Manager Server 
is started (or the updater is created).  Enter a number in the text field 
and choose Hours, Minutes, or Seconds from the drop-down list. 

• On the Recurring Period – The maintenance action is performed on a 
specific recurring period.   

2. Select one of six options under Action: 

• Do Nothing – disable maintenance; no action will be taken. 

• Stop Adding Records – updates will halt and no more updates to the 
database will occur. 

• Delete All Records – deletes all records in the table. 

• Delete Oldest X% of Records – deletes some percentage of the oldest 
records in the table.  Enter a percentage in the text field.   

• Delete Records Older than X <time> based on timestamps from 
column: Y – deletes records older than the configured time period 
based on the specified date/time column.  All columns that use an 
ExpDATETIME type can be used for reference. 

• Invoke Stored Procedure – Invokes the stored procedure with the 
specified name.  This must be a zero parameter procedure.  Enter the 
name of the procedure in the text field. 

3. Select OK to complete the configuration. 

17.13. Edit Recurring Action Schedule 

  

Figure 19 

On the Maintenance Options dialog, when you select On the Recurring Period 
option and the additional options button (Figure 19), the Edit Recurring Action 
Schedule dialog appears. 

The Edit Recurring Action Schedule dialog is used to define a recurring schedule 
that will be used for the maintenance action.  A recurring schedule combines 
both a specification for what days to trigger on, and when to occur within a day. 
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1. Select one of the three options under Occurs: 

• Daily – The action will happen every day. 

• Weekly – The action will only happen on the specified days of the 
week.  Select one or more days. 

• Monthly – The action will happen on a specified day of the 
month.  Select the day from the drop-down list. 

2. Select one of the two options under Daily Frequency: 

• Occurs once at: - The action will occur once a day at the specified 
time.  Select a time using the pick list. 

• Occurs every: - The action can occur multiple times.  Within the day 
the action will reoccur every so many hours between the starting and 
ending times. Select the number of hours, beginning time, and end 
time. 

3. Select OK to complete the configuration. 

17.14. AutoFill 

Autofill is an option in the Field Mapping menu bar that contains commands for 
filling tables automatically (Figure 20). 

 

Figure 20 

17.15. Create Columns from Group 

When you select Create Columns from Group from the AutoFill option, the 
Automated Column Creation dialog appears (Figure 21).   
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Figure 21 

Columns are automatically created for every field in the group you select.  If there are no 
columns configured, this will automatically populate the first row with the fields in the 
selected group.   This is only available when configuring new tables. 

To complete this dialog: 

1. Choose Select a Group. 

2. The Create Columns From Group dialog appears.  Columns in the table 
will be created based on the fields in the selected group.  If there are no 
columns previously configured in the table, a single row is automatically 
created and populated with the fields in the selected group. 

3. Once you have selected a group, click OK to return to the Automated 
Column Creation dialog 

4. The next step is to select whether to specify table columns in addition to 
the default columns. The dialog will initialize with Record Number, Date 
and Time Stamp, and Group or Row Name selected if there are no 
columns in the table.  If columns are already in the table then all the 
additional columns will default to unchecked. 

5. Select none, one, or any combination of the four options under Create 
Additional Columns For: 

• The Record Number column has its values set by the OCM when the 
record is written.   

• The Date/Time Stamp columns have their values set by the OCM 
when the record is written.    

• The default value for Group or Row Name columns will be Data Field 
Group Names.   
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• The default value for Source or Row Name columns will be Data 
Source Names.   

6. Enter a Default String Length.  The Default String Length field defines the 
string width to use if a column is given a String type.  This will be the 
maximum width of the string values.  Invoking this command multiple 
times will only create new columns provided columns with matching 
names do not already exist. 

7. Select OK to complete the configuration and return to the Field Mapping 
dialog. 

17.16. Fill Row From Group 

The selected Data Field Group is used to populate all fields in the current row by 
matching column names with data field names. 

When you select Fill Row From Group, the Use Fields From Group dialog 
appears.   

To complete this dialog: 

1. Search the directory for the group. 

2. Choose Select a Group. 

3. Select OK to return to the Field Mapping dialog. 

The table is populated with data from the group you selected (Figure 22). 

 

Figure 22 

17.17. Replacing Existing Entries 

The following steps detail how to replace existing entries from the Group 
dialog.  When you select the option Fill Row From Group from the menu bar, the 
Use Fields from Group dialog appears.   
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After you select the group and click OK, if the fields in the row already have 
values the user is prompted to replace the entry. 

The options include: 

• Yes – Replaces just this entry. 

• Yes to All – Replaces this entry and automatically answers yes to any 
other replace conflicts during this operation.  The “Replace existing 
entry?” Dialog will not get shown again for this operation. 

• No – Do not replace.  Applies to just this entry. 

• No to All – Does not replace this entry and automatically answers no 
to any other replace conflicts during this operation. 

• Cancel – Cancels the operation completely. 

17.18. Create Table From Data Source 

The option to Create Table from Data Source is similar to Create Columns From 
Group except it also automatically adds and fills in rows for all groups within 
the data source. This is only available when configuring new tables. 

This option will be grayed out if the Update Option has been set for “On 
Reception of Data Set Contracts”.  Each contract acts more like its own group, so 
the concept of Data Sources does not apply with contract updates. 

When you select Create Table from Data Source, the Automated Column 
Creation dialog appears.   

 

Figure 23 
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Columns are automatically created for every field in the group selected by the user.  If 
there are no columns configured, this will automatically populate the first row with the 
fields in the selected group.   This is only available when configuring new tables. 

To complete this dialog: 

1. Choose Select a Group. 

2. The Create Columns From Group dialog appears.  Columns in the table 
will be created based on the fields in the selected group.  If there are no 
columns previously configured in the table, a single row is automatically 
created and populated with the fields in the selected group. 

3. Search the directory for the group. 

4. Select a group. 

5. Select OK to return to the Field Mapping dialog. 

Select Refresh to update the list of groups.   

6. The next step is to select whether to specify table columns in addition to 
the default columns. The dialog will initialize with Record Number, Date 
and Time Stamp, and Group or Row Name selected if there are no 
columns in the table.  If columns are already in the table then all the 
additional columns will default to unchecked. 

7. Select none, one ,or any combination of the four options under Create 
Additional Columns For: 

• The Record Number column has its values set by the OCM when the 
record is written.    

• The Date/Time Stamp columns have their values set by the OCM 
when the record is written.   

• The default value for Group or Row Name columns will be Data Field 
Group Names.   

• The default value for Source or Row Name columns will be Data 
Source Names.   

8. Enter a Default String Length.  The Default String Length field defines the 
string width to use if a column is given a String type.  This will be the 
maximum width of the string values.  Invoking this command multiple 
times will only create new columns provided columns with matching 
names do not already exist. 

9. Select OK to complete the configuration and return to the Field Mapping 
dialog. 
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17.19. Fill Table From Data Source 

When Fill Table from Data Source is chosen, the selected data source is used to fill 
in all empty locations in the table based on matching row names to group names 
and column names to field names. 

When you select Fill Table from Data Source, the Use Fields From Source dialog 
appears.   

To complete this dialog: 

1. Search the directory for the group. 

2. Select a Source. 

3. Select OK to return to the Field Mapping dialog. 

Select Refresh to update the list of groups.   

The empty locations in the table are filled in based on matching row names to 
group names and column names to field names. 

17.20. Configuration 

Configuration is an option in the Field Mapping menu bar that contains 
commands for loading, saving, and validating table data. 

This option will be grayed out if the Update Option has been set for “On Reception of 
Data Set Contracts”.  Each contract acts more like its own group, so the concept of Data 
Sources does not apply with contract updates. 

Load from File – Initializes the update options, maintenance options, and field 
mappings based on a previously saved file.  This uses the standard File Open 
dialog.  This is currently only available for new tables.   

Save to File – Saves the existing configuration, including the update options, 
maintenance options, and field mappings to a file.  This uses the standard File 
Save Dialog. 

Validate – Runs all the validation checks for the configuration.  The validation 
rules include: 

• At least one column exists in the configuration. 

• All columns have a storage type specified. 

• Each column has a unique name. 

• All fields in columns that do not support NULL values are defined. 

• All columns marked as primary keys do not have duplicated values. 
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• If doing snapshot style updating, at least one column is defined as a 
primary key. 

• If doing snapshot style updates, no columns are set for TimeStamps 
and as a Primary Key. 

• If doing historical style updates, there is at least one primary key 
column in addition to the group name and/or source name column. 

• If Update Option is set for Contract Data Sets then there must be at 
least one contract field configured in each row. 

• If Update Option is not Contract Data Sets then there cannot be any 
contract fields configured in any rows. 

• Each row can only utilize contract fields from a single contract.  Fields 
from multiple contracts cannot be mixed within a row. 

17.21. Field 

Field is an option in the Field Mapping menu bar that contains commands 
related to individual fields in the table.  The commands are very similar to 
standard editing commands found in most software.   

You can select the command from the menu or use the corresponding short cut 
keys.  The options in the Field menu include: 

• Undo (Ctrl + Z) – Undo the last field mapping related change.  The 
AutoFill actions cannot be undone. 

• Redo (Ctrl + Y) – Redo the last undo change. 

• Cut (Ctrl + X) – Cut the current field into the paste buffer. 

• Copy (Ctrl + C) – Copy the current field into the paste buffer. 

• Paste – Autofill Data Fields (Ctrl + V) – Fill the current location with 
the contents of the paste buffer.  All data fields used in the field buffer 
are AutoFilled based on matching row names to group names and 
column names to field names.  If there is no AutoFill match 
(group/column names do not match), then the originally copied value 
is pasted. 

• Paste – As Originally Copied – Fill the current location with the 
contents of the paste buffer in its exact form. 

• Delete (Del) – Delete the contents of the current location. 

• Set Field (Spacebar) – For Data Field / Expression columns this 
launches the Data Field Expression dialog.  For Group or Row Name 
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Columns this will launch the Select a Group Name dialog.  For 
Location or Row Name Columns this will launch the Select a Data 
Source Name dialog. Double clicking within the grid will also invoke 
this command. 

• Edit Field – Launch the Specify Field Value dialog.  This supports the 
ability to specify a constant value, along with the Set Field 
functionality. 

17.22. Field - Data Field Expression 

On the Field Mapping dialog, when the cursor is in a data field, pressing the 
space bar opens the Data Field Expression dialog.  

Refer to the Data Field Expression User Guide to learn how to use this tool. 

17.23. Field - Select a Group Name 

On the Field Mapping dialog, when the cursor is in Group or Row Name Columns, 
pressing the space bar opens the Select a Group Name dialog.  

Using this dialog you can insert data from the group into the group or row 
column. 

1. Select the group. 

2. Select OK. The group name is inserted in the group or row column. 

17.24. Field - Select a Data Source Name 

On the Field Mapping dialog, when the cursor is in Location or Row Name 

Columns, pressing the space bar opens the Select a Data Source Name dialog.  

Using this dialog you can insert data from the data source into the location or 
row column. 

1. Select the data source. 

2. Select OK. 

3. The data source is inserted in the location or row column. 

17.25. Specify Field Value 

When you select Edit Value from the Field menu items, the Specify Field Value 
dialog appears. This dialog has can display slightly different functionality 
depending what is chosen in the table. 



LightLink Administrator 
User Guide 

 

All claims and information in this document are based on information publicly available at time of printing.  
All other product or service names mentioned in this document may be trademarks of the companies with which they are associated.  

© 2021 Inova Solutions  |  All rights reserved  |  page 68 

When a Data Field, Expression, or Constant value column is selected, the Specify 
Field Value Dialog (Figure 24) is presented to allow you to specify the value to be 
written in the column. 

 

Figure 24 

When a Row Name column is selected, the Specify Field Value dialog (Figure 25) is 
presented to allow you to specify the value to be used for the row name.  A Row 
Name is always constant, and always has the fixed type that was assigned in the 
column configuration. 

 

Figure 25 

To complete this dialog: 

1. Select Set Row Name or Select Datafield Expression.  

• For Group or Row Name columns, this presents the Select a Group 
Name dialog which lists the Data Groups in the system. 

• For Location or Row Name columns, this presents the Select a Data Source 
Name dialog which lists the Data Sources in the system. 

• For Data Field, Expression, or Constant value column, this presents the 
Data Field Expression dialog. 

2. Select a Group Name, Data Source Name, or complete the Data Field 
Expression dialog. 

3. Once you have completed any of these dialog options, select OK to return 
to the Specify Field Value dialog. 

The users can also manually enter a typed name in the Edit box. 



LightLink Administrator 
User Guide 

 

All claims and information in this document are based on information publicly available at time of printing.  
All other product or service names mentioned in this document may be trademarks of the companies with which they are associated.  

© 2021 Inova Solutions  |  All rights reserved  |  page 69 

4. Complete the rest of the options on the dialog : 

• Clear Field – Resets the value to be NULL 

• Make Constant/Fixed Value – This allows the user to enter a value by 
hand.  The Select Data Field or Expression and Clear Field Buttons will 
be disabled.  The Inova LightLink Type will be enabled. 

• Inova LightLink Type – This will default to be the type specified by 
the column.  When setting a constant value, this defines the type that is 
associated with the constant value. 

When the dialog is OKed, the value (either the constant or the type of the data 
field or expression) must be compatible with the type of the column.  If the types 
are not compatible an error is presented and the dialog remains open. 

17.26. Row 

Row is an option in the Field Mapping menu bar that contains commands related 
the rows in the Field Mapping table.  

There are two commands available in Row. 

• Add Blank Row – Adds an additional empty row to the bottom of the 
table. 

• Delete Row – Deletes the currently selected row and all its values. 

17.26.1. Column 

Column is an option in the Field Mapping Menu bar. The Column Configuration 
dialog is used to specify the properties for a new Column or to change the 
properties of an existing column. 

During creation of a new database table, all properties will be active.  When the 
OCM creates the table in the database the format will be based on this 
configuration. 

When configuring an existing database table only the Storage Type, Is a Key 
Field, and Allow Null Values selections will be active.  Changing the Is a Key 
Field and Allow Null Values properties will not cause the table format in the 
database to be changed.  It will only affect the validation rules for the 
configuration.   When configuring a stored procedure only the Storage Type will 
be active. 

You can also access the same commands by right clicking in a column to open the 
Column context menu. 
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17.26.2. Create Column 

When you select Create New Column or Edit Column from the Column menu 
commands, the Column Configuration dialog appears (Figure 26).  

 

Figure 26 

Once this dialog is completed, the system adds a new column to the right side of 
the table.  To complete the Column Configuration dialog: 

1. Select one of the five options from the Storage Type: 

• Data Field, Expression, or Constant – This column will store either a 
Data Field value, an Expression, or a constant value.  The user can 
specify what to store for each row in the table. 

• Group or Row Name – This tells the OCM that this column is a row 
name column and should be associated with Inova LightLink Datafield 
Group Names.  The association is used for doing the Data Field 
AutoFill operations.  For each row in the table the user is able to 
specify a unique row name field.  By default this column is considered 
to be a Primary Key field. 

• Location (Source) or Row Name – This tells the OCM that this column 
is a row name column and should be associated with Inova LightLink 
Data Source Names. 

• Update Time Stamp – This tells the OCM to store the current date and 
time when the update occurs. 

• Record Number – This tells the OCM to store the current record 
number at the time of updating.  When doing snapshot (overwrite) 
updating the record number will never change and will increment for 
each row in the configuration.  When doing historical updating, if the 
record number is the only primary key then its value will increment 
with every row updated.  If there are other primary key columns then 
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the record number increments each time an update occurs, but each 
row written within one update cycle will have the same record 
number. 

2. Enter a column name.  You can either simply type the name of the column 
or select the name from a data field by clicking Set From a Data Field Name. 
This opens the Select a Field Name dialog. 

3. Select a name from this dialog: 

a. Navigate through the data hierarchy  

b. Select a field name 

c. Click OK. 

4. On the Column Configuration dialog, enter a Data Type.  This specifies 
the Inova LightLink type for the field.  Only the known Inova LightLink 
types that can be universally supported as a database column type are 
available.  The specific database column type is determined based on what 
the database supports.  If the DB Admin wants the column to have a 
specific type non-Inova LightLink supported type, then the table should 
be pre-created in the database and a LightLink Database Updater can be 
mapped onto the table. 

5. Select a Width from the pick list.  If the Type is specified as String, then 
this specifies the width of the string field. 

6. Select or deselect the Is a Key Field check box.  If this is checked then this 
column is treated as a primary key field.   This means that all values in the 
column must be unique, and it is useable for identifying a particular row 
in the database table.  If this is checked then May Be Null is false and 
disabled. 

7. Select or deselect the Allow Null Values check box.  If this is checked, then 
it is valid for a field within this column to have an undefined value.  If 
unchecked then all rows within the column must have a value defined for 
them. 

8. Select OK to accept configuration changes. 

17.26.3. Edit Column 

When you select Edit Column from the Column menu commands, the Column 
Configuration dialog appears.  

This dialog displays the values of the column selected in the Field Mapping 
dialog.   
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Double-clicking on the column also opens the Column Configuration dialog. 

Refer to Section 17.26.2 for details about the fields on the Column Configuration 
dialog.   

17.26.4. Move Column 

To move a column using the Move Column menu command: 

1. Select the column you want to move. 

2. Select Move Column from the Column menu commands. 

3. The Enter New Column Position dialog appears. Enter the number 
corresponding to the column position for the new column.   Movement is 
based on a numerical ordering of the columns where the first (left-most) 
column is number one. 

4. Select OK to move the currently selected column and all its values. 

17.27. Change View 

Change View is an option in the Field Mapping menu bar that you can use to 
change the view of the Field Mapping table.  

Field Mappings – The grid displays all field mappings.  Columns represent the 
columns in the database; rows represent the rows that will get written.  

Columns Definitions – The grid displays just the information about the 
columns. This view gives a quick overview of all the column properties without 
having to launch the Column Configuration Dialog for each column. (Figure 27) 

 

Figure 27 

This option is not available for stored procedures. 
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17.27.1. Visible Column 

The Visible Columns attribute provides an easy way to specify the number of 
visible columns shown in the grid (Figure 28).   

 

Figure 28 

Choose a number from the pick list.  Column widths are automatically formatted 
to fill the available window width. 

17.27.2. Updating Check Box 

The When Updating, Only Process Rows with New Data Values option is used to 
limit the number of updates that are performed. 

Each row in the configuration represents an update statement or stored 
procedure call.  When this option is checked an update is only performed for a 
row if its values have changed since the last update.  When unchecked, updates 
for all rows will always be written when the update condition is true.  
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18. XML Publisher Output 

18.1. Overview 

The XML Publisher Output is the Output Channel Manager (OCM) for 
publishing LightLink data into a XML format.  XML devices manage the 
publishing of configured data for immediate viewing in raw XML format and 
transformed into other formats using XSLT technology. 

The XML OCM allows you to distribute Inova LightLink data and messaging to 
the web or to a corporate intranet. Because it employs XML technology, XML 
OCM is capable of dynamically refreshing the information that appears.  For 
example, XML OCM can take a customized DataLink View and publish it as an 
XML file suitable for display on the company intranet.  The XML OCM also 
supports publishing a set of LightLink messages into an XML file. 

18.2. Configuring XML Publisher Channel Properties  

To configure the XML Publisher Output Properties: 

1. Select XML Publisher Output from the New Output Device Connection 
dialog.   

2. Select OK.  

3. Select the General tab on the XML Publisher Output Properties dialog. 

Enter the name, server ID, preferred ID, and remote host on the XML 
Publisher Output Properties General tab.  If Disable is checked, all devices 
are inactive. 

4. Select the Settings tab on the Properties dialog. 

Complete the XML Publisher Output Properties Publishing Mode 
Settings. Click the Browse button to select a different directory in the drop 
down for Default Output Directory. The server\srvcfg\odms directory is 
commonly used for this directory location. 

The only configuration supported by the channel is an optional default location 
for the files to be written. This will be the default output location when creating 
devices for the channel. The default location for XML files to be written is the 
server\srvcfg\pub directory in the LightLink installation directory. This 
directory does not exist, but you can create this directory if needed. 

5. Select OK to complete the configuration. 
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18.3. Adding a Device 

Once you have created a new output device for Inova LightLink XML Publisher, 
the Add Devices option becomes available from the General dialog. 

1. Select Output Manager > XML Publisher Output > Properties > Add 
Devices. 

2. The XML Publisher Output Properties dialog appears.  Select the General 
tab. 

3. Select Add Devices.   

4. The XML Device Properties dialog appears (Figure 29).   

 

Figure 29 

Complete the File Settings options for adding a device: 

• Device Type - Choose from Data Table XML or Simple Messaging 
XML.  To use a DataLink View as your source, select Data Table XML. 

• Output XML File Location - Click Browse to browse to the location 
where the XML file will be published. The default is the 
server\srvcfg\pub directory under the installation folder.  

• Device Name - enter the name for the device. 

• File Update Interval (ms) - number of milliseconds Inova LightLink 
will wait before checking for data field updates to the DataLink View 
file. Inova recommends you keep this default setting.  

• Data Table (LLD) File Location - Click Browse to locate the stored Data 
Table file.  You can recognize it by the .lld file extension. The default 
directory is your My Documents folder, but you may have already 
created a special folder for DataLink Views.   
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5. Select the Transformation Settings tab.  

Complete the Transformation Settings options for adding a device: 

• (XSL) File Location - enter the (XSL) file location or click Browse to 
choose the file location. 

• Transformed File Location - enter the transformed file location or click 
Browse to choose the file location. 

6. Select OK to complete the configuration. 

18.4. Context Menu 

The XML Publisher Output context menu (Table 12) is content sensitive and will 
have different items depending on the tree nodes selected. 

Menu Item Explanation 

Add to View Window Adds this to an open view window 
New Device Add a new Device 
Rename Allows you to rename XML Publisher 
Delete Allows you to delete XML Publisher 
Properties Modifies the diagnostic level and the expired/canceled 

messages interval settings (Access Advanced Settings 
for use by Inova Technical Support) 

Table 12 
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19. LightLink Email Output 

19.1. Overview 

The Inova Email OCM supports sending LightLink messages via Email. The 
Email OCM uses the common SMTP standard to send LightLink messages to 
your email server and from there to desired email destinations.  The complete 
message scheduling capability of LightLink is available for these messages, 
making them ideal as notification emails for various types of events. 

The Email OCM will only have one top-level “device”, named “To: Address”, 
which is a placeholder for the email addresses to which messages can be sent. 
Destination email addresses can be created in System Manager as virtual devices 
in the same way as virtual devices are created for other types of output devices. 

You can also create additional email addresses in the Message Editor destination 
dialog when editing a message.  Note that when you enter new addresses in this 
way, these addresses will not be retained as virtual devices for later use.  The 
only references to these additional email addresses will be in the message 
destinations as viewed in System Manager.   

Each Email OCM will have a log stream that can be viewed in Log Viewer.  The 
log will retain diagnostic information about the sending of email messages.     

19.2. Configuring an Email Output Channel 

To configure an Email Output Channel: 

1. Select Output Manager > New Output Device Connection.  

2. The New Output Device Connection dialog appears. Select Email Output. 

3. Select OK. 

4. The Email Output Properties dialog appears. Select the General tab.  Enter 
the name, server ID, preferred ID, and host on the following Email Output 
Properties General tab.  Check the Disable option to disable the OCM. 

5. Select the Settings tab on the Properties dialog. 

Complete the following Email Output Properties Settings tab options:   

• Server - name of SMTP Server address that provides mail sending 
services.  This can either be a numeric IP Address or a machine name. 

• From Address - the address the email recipient will see as having sent 
the email.  The following formats are valid:  Joe Rice 
<joe@acme.com> or joe@acme.com or joe @ Acme.com.  
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• Port - Internet server port designated for SMTP mail service; this is 
usually set at 25 for SMTP mail which is the default value of the 
property. 

• Connection Timeout - timeout in milliseconds to be used in SMTP 
server connections.  This includes the period of time from the 
beginning of the first mail event until a connection is established.  The 
default is 30000 (30 seconds).  The minimum value is 2000 and the 
maximum value is 60000.     

• User name – optional user name for authentication with the mail 
server. 

• Password – optional password for authentication with the mail server.  

6. Select OK to complete the configuration changes. 

19.3. Configuring Email Addresses in LightLink  

There are two methods for creating email addresses in LightLink for use in 
sending messages via the Email Output Channel: creating email addresses as 
virtual devices in System Manager and adding email addresses in the message 
destination dialog in Message Editor. 

In System Manager, select the “To: Address” node in the LightLink system tree, 
right-click, and select Virtual Devices > Define.  Enter up to five email addresses; 
repeat these steps to enter additional email addresses. Refer to the System 
Manager User Guide for more details. 

In Message Editor, bring up the Select Destination dialog for a message (refer to 
the Message Editor user Guide for details), open the Email OCM node in the 
LightLink system tree, and click on the “To: Address” node.  This brings up the 
“Enter Email Addresses” dialog, with which you can create up to five email 
addresses (repeat to create more email addresses).  
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20. Inova TCP/IP Displays – Encrypted 

20.1. Overview 

The Inova TCP/IP Displays - Encrypted OCM type allows LightLink to connect 
to the Inova OnAlert® family of LED displays manufactured by Inova Solutions, 
and thereby to display messages on those displays.  The connections to these 
displays are encrypted, protecting the data in transit from the LightLink system 
to the displays.  Only one TCP/IP Displays – Encrypted OCM is supported per 
LightLink Output Manager.   

The Inova Displays connecting to this output channel must be in the Inova 
OnAlert display family with firmware version 1.4.140.  This functionality is no 
longer supported by Inova Solutions.   Customers who still use this tool can refer 
to the Display Connector Installation Guide for assistance.   
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21. AMS LED Displays 

21.1. Overview 

The AMS LED Displays output channel type allows LightLink to connect to LED 
displays manufactured by Adaptive Micro Systems (AMS), and thereby to 
display real-time data and messages on AMS LED displays. 

21.2. AMS LED Displays Output Device Connection 

As an Output Device Connection, AMS LED Displays support multi-region 
messages and multi-page messages. However, message regions must cover the 
entire width of the display, and all message regions on a page must have the 
HOLD presentation mode. 

21.3. Configuring AMS LED Displays 

To configure the AMS LED Displays: 

1. Select Output Manager > New Output Device Connection. 

2. The New Output Device Connection dialog appears.   Select AMS LED 
Displays. 

3. Select OK. 

4. The AMS LED Displays Properties dialog appears (Figure 30). Select the 
General tab. 

 

Figure 30 
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Enter the name, server ID, preferred ID, and remote host on the AMS LED 
Displays Properties General tab. 

5. Select the Connection tab on the Properties dialog. 

Complete the following AMS LED Displays Connection tab: 

• Connection Port - This selection configures the connection to use a 
serial port, or COM port, on the PC. 

Inova LightLink Displays, with the exception of the Inova LightLink IP-
Addressable Display (TCP/IP Display), may be connected only via serial 
connection. 

• COM port - This specifies the serial port for this connection.  The 
"COM port" setting must be a valid serial port number, e.g., "1", and 
must be the serial port that is connected to the Display network. 

• Select the baud, parity, data bits, and stop bits from the drop down 
lists to specify the serial port parameters for this connection. 

Examples: 

− If the display network is sub-only (i.e., there is no main Display), 
the proper settings are: 

Baud: 9600 

Parity: Space  

Data bits 8  

Stop bits 1: 

− If the display network is not sub-only (i.e., there is a main Display), 
the proper settings are: 

Baud: 9600  

Parity: None  

Data bits 8  

Stop bits 1:   

6. Select OK to complete the configuration. 

21.4. Adding AMS LED Displays  

Once you have created a new output device for AMS LED Displays, the Add 
Devices option becomes available from the General dialog. 

The Add Device Dialog specifies the display Address (1-255) and the display 
dimensions in rows and columns.  Additionally, in the case of TCP/IP signs, also 
specified are the IP Address and port of the display to which the control makes a 
socket connection. 

To set up an AMS LED Displays Output Device Connection: 
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1. Select Output Manager > AMS LED Displays > Properties. 

2. The AMS LED Displays Properties dialog appears.  Select the General tab. 

3. Select Add Devices.  

4. The AMS Display Properties dialog appears.  Complete the following 
AMS Display Properties options: 

• Display ID - enter the ID number from the range of 1-255. 

• Rows - enter the number of rows using the arrow keys (increments of 
8). 

• Columns - enter the number of columns using the arrow keys 
(increments of 8). 

• IP Address or Hostname - enter the IP Address or Hostname for this 
display. 

• Port - enter the port number. 

5. Select OK to complete the configuration. 

21.4.1. Adding Additional Devices  

After you have added one device to the AMS Display, you can go return to add 
additional devices using the New Device option.   

To access and configure the AMS LED Display New Device option, select Output 
Manager > AMS LED Displays > New Device. 

The AMS Display Properties dialog appears, which you can configure following 
the steps in Section 21.4. 
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22. Administrator Menu Commands 

Refer to Table 13 for information about the Administrator menus. 

Administrator Menu Menu Item Explanation 

File Menu 

 

New Create a view window 
Open Open a previously saved view 

window file 
Close Close a view window 
Save   Save the items in the selected view 

window to a file 

Save As Save the items in the selected view 
window to a file using another 
filename 

Exit Exit Inova LightLink Administrator. 

Edit Menu 

 

Delete List Item Select this menu option to delete the 
selected item from a list of items in a 
view window 

Delete Tree Item Delete the currently selected item 
from the LightLink system tree 

Node Select a node and choose Edit | 
Node. The cascade menu appears. 
Depending upon the item you have 
selected, the Node menu varies 

View Menu 

 

Standard Display the Toolbar buttons when 
checked 

Status Bar Display the Status bar at the bottom 
of the main screen when checked 

Host View Shows the Host View of Server 
Components selected 

Global View Shows the Global View of Server 
Components selected 

Startup View Shows the Startup View 
Refresh Refreshes the LightLink system tree 

image to reflect any changes that 
have been made 

Tools Menu 
System Manager Launches System Manager 

 
Message Editor  Launches Message Editor 
Security Manager   Launches Security Manager 
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Log Viewer Launch the Inova LightLink Log 
Viewer to display diagnostic 
information 

Config Permissions Select Config Permissions to release 
or request permission to modify the 
current system configuration 

Options Use this feature to adjust timeout, 
garbage collection, and update 
settings. 

  

Window Menu 

 

Cascade This option arranges open view 
windows one behind the other and 
overlapped, as in Solitaire 

Tile   This option arranges open view 
windows side by side, edges 
touching with no overlap 

Table 13 


